Revision history

April 2000
Standard 6.00. This is a global document and is up-issued for X11 Release 25.0x.

June 1999
P0907375, Standard, Release 5.00. This document was upissued for technical content.

April 1998
P0882201 Standard, Release 4.00. This document was upissued for technical content.

October 1997
P0872703 Standard, Release 3.00. Initial release (Release 1.00 and 2.00 were not published).
Contents

About this guide ........................................ 11
   About the NT5D61 IODU/C card ....................... 12
   Software install kit .................................. 13
   Security device ....................................... 14
   Keycodes .............................................. 15
   Feature expansion .................................... 17
   Software upissues .................................... 17
   Database transfer ..................................... 17
   How does the IODU/C card differ from the IOP/CMDU card? 18

Installing the IODU/C card .......................... 19
   Installation procedures for Options 61C, 81, and 81C .......... 20
      Perform a data dump ................................ 21
      Split the cores ..................................... 22
      Transfer the database to 2MB ....................... 23
      Upgrade Core 1 ..................................... 24
      Switch call processing from Core 0 to Core 1 .......... 28
      Upgrade Core 0 ..................................... 29
      Return the system to redundant mode .................. 33
      Complete the upgrade ............................... 33
   Installation procedure for Option 51C systems .......... 35
      Perform a data dump ................................ 35
      Transfer the database to 2 MB ..................... 36
      Install the IODU/C card ............................ 37
      Complete the upgrade ............................... 40
## Software conversion

- Parallel reload Options 61C/81/81C
- Verify memory
- Perform a data dump
- STAT the hardware
- Split the Cores
- Install software on Core 1
- Exiting split mode
- Test Core 1 and Core 0
- Synchronize the hard disks
- Perform a data dump
- Backing out of the parallel reload on the Option 61C/81/81C

### Option 51C software conversion

- Verify memory
- Perform a data dump
- STAT the hardware
- Install software
- Check for Peripheral Software Download
- Test call processing
- Complete the upgrade

## Adding features and ISM limits

- Installing a keycode from diskette
- Place the system in split mode
- Install the new keycode in Core 1
- Switch call processing
- Return the system to redundant mode
- Synchronize the hard disks

- Transferring the keycode file electronically
- Place the system in split mode
- Install the new keycode in Core 1
- Switch call processing
- Return the system to redundant mode
- Synchronize the hard disks

- Entering the keycode manually
Contents

Creating keycode diskettes

Replacing an IODU/C card

Replacing the IODU/C in a redundant system
Performing a data dump
Split the Cores
Replace the IODU/C card
Return the system to redundant mode
Replacing the IODU/C in an Option 51C

Replacing the security device

Replacing the security device on a redundant system
Replacing the security device on an Option 51C system

Database transfer

Database transfer for Options 21E, 51, 61, 71,
STE, NT, and XT systems
Using the Database Transfer Utility
Using the direct cabling method
Database transfer for Option 51C, 61C, 81, and 81C systems
Using the Database Transfer Utility
Using the Copy database command
Databases on X11 release 16 G (Phase 7)

IODU/C Software Installation Tool

Status Summary Charts
Messages
Introductory Screen
Install Menu
Installing Software, CP-BOOTROM, and IOP-ROM
Installing Software, Database, CP-BOOT ROM, and IOP-ROM
Installing Software only
Installing Database only
Installing CP-BOOT ROM
Installing CP-ROM
Contents

Installing IOP-ROM ........................................ 168
Reinstalling CP-Software ................................. 169
To copy system software from the other Core .......... 169
To go to the Tools Menu ................................ 169
To Install Keycode only .................................. 169
To quit ...................................................... 169

Tools Menu .................................................. 171
Setting the system date and time ....................... 174
Partitioning the hard disk ............................... 174
Displaying the hard disk partition size ............... 175
Regenerate the PDT password ......................... 175
To print the CD-ROM content ......................... 175
To print the Keycode content ......................... 176
To print the Security Device content ............... 177
To check the customer-specific part of the CD-ROM .. 177
To manually create a Keycode diskette .............. 177
To install Keycode only .................................. 177
To archive the existing database ..................... 178
To check MDU connection .............................. 178
To return to the Main Menu ......................... 178

Fault isolation ............................................. 179

System messages .......................................... 183

List of Terms .............................................. 197
About this guide

This document contains the following procedures related to the NT5D61 Input Output Disk Unit with CD-ROM (IODU/C):

- If you are installing a new IODU/C card, see page 19
- If you are converting from one X11 software release to another, see page 43
- If you are performing a software upissue, see page 43
- If you are adding features or ISM limits, page 63
- If you are downloading keycodes from the Distributor Keycode Server, see page 87
- If you are downloading keycodes using the Keycode Retrieval Utility, see page 107
- If you are using the keycode commands in LD 143, see page 121
- If you are replacing a faulty IODU/C card, see page 123
- If you are replacing a faulty security device, page 133
- If you are transferring a 4 MB database to 2 MB, see page 141
About the NT5D61 IODU/C card

The NT5D61 Input Output Disk Unit with CD-ROM (IODU/C) card introduces CD-ROM software delivery to Meridian 1 systems Options 51C, 61C, 81, and 81C.

The software installation process for IODU/C based systems is similar to the process defined for IOP/CMDU or IOP and CMDU systems, with the following exceptions:

- Software installation from CD-ROM and one Install Program diskette.
- During the software installation process, a security device and keycode diskette are used to activate features and ISM limits rather than a security cartridge.
- Database backup and restore is supported using an industry-standard 2 MB floppy drive rather than a 4 MB drive.
- For redundant systems, software is installed onto Core 1 and then copied to the other Core. This eliminates software installation onto both Cores. (CP-BOOT ROM and IOP-ROM must be upgraded on both Cores.)
- For redundant systems, the database is copied from the redundant side.
- Each processor type (68060, 68040, 68030) has a distinct Install Program and Database Transfer Utility diskette.

In the NT5D21 Core/Net module, the IODU/C occupies slots 17, 18, and 19. In the NT9D11 Core/Net and NT6D60 Core modules, the IODU/C card occupies slots 16, 17, and 18.
Software install kit

The Software Install Kit is a generic set of X11 software and utility programs that are specific to a single release and issue of X11 software. A new kit must be obtained when upgrading to a new release or issue of software.

Table 1 lists the contents of the Software Install Kit.

<table>
<thead>
<tr>
<th>Item</th>
<th>Quantity</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>X11 software CD-ROM</td>
<td>1</td>
<td>Each CD contains all nine generics for a given release and issue of X11 software.</td>
</tr>
<tr>
<td>CP Install Program diskettes (2 MB media)</td>
<td>3</td>
<td>Used to launch the Install Program and to download software from the CD-ROM. Each 2 MB diskette supports one processor type (68030 68040, or 68060).</td>
</tr>
<tr>
<td>Database Transfer Utility diskettes (4 MB media)</td>
<td>3</td>
<td>Used to transfer the customer database from an IOP/CMDU drive onto 2 MB diskettes that can be ready by the IODU/C. Each 4 MB diskette supports one processor type (68030 68040, or 68060).</td>
</tr>
<tr>
<td>Distributor Keycode Application diskette (2 MB media)</td>
<td>1</td>
<td>A Windows 95 utility that supports download of keycodes from a keycode server.</td>
</tr>
<tr>
<td>Database diskettes (blank, 2 MB media)</td>
<td>2</td>
<td>Blank 2 MB diskettes that can be used to archive the customer database.</td>
</tr>
<tr>
<td>Keycode diskette (blank, 2 MB media)</td>
<td>1</td>
<td>A blank 2 MB diskette that can be used to store a back-up copy of the keycode file.</td>
</tr>
</tbody>
</table>

See Software Conversion Procedures (553-2001-320) for software installation procedures.
Security device

The IODU/C security device and keycode replace the functionality of the IOP/CMDU security cartridge. The security device is located in the top right corner of the IODU/C motherboard and controls the software feature functionality and Incremental Software Management (ISM) limits.

During software installation, the keycode must validate against the information contained in the security device. To identify matching security devices and keycodes, match the 8-digit code on the security device and the keycode diskette label. This code is referred to as the NT SDID.

The security device is intended to serve the customer through system upgrades and features changes, and is replaced only if damaged.

Each software order contains the Security Device Kit. The contents of the Security Device Kit are listed in Table 1.

Table 2
Contents of the Security Device Kit

<table>
<thead>
<tr>
<th>Item</th>
<th>Quantity</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keycode diskette (2 MB media)</td>
<td>1</td>
<td>A 2 MB diskette containing the keycode file.</td>
</tr>
<tr>
<td>Keycode acknowledgment</td>
<td>1</td>
<td>A hard-copy printout of the keycode file, including a listing of the parameters for which the keycode was created.</td>
</tr>
<tr>
<td>Security devices</td>
<td></td>
<td>The number of security devices provided is determined based on the type of order and the number of security devices previously provisioned:</td>
</tr>
<tr>
<td></td>
<td>0</td>
<td>When security devices have already been provisioned</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>For single CPU systems</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>For upgrades from single CPU to dual CPU systems</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>For replacing single, lost, or damaged security devices</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>For dual CPU systems</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>For replacing two lost or damaged security devices</td>
</tr>
<tr>
<td>Database diskettes (2 MB media)</td>
<td>2</td>
<td>One 2 MB diskette containing the CE database and one 2 MB diskette containing CE/PE database.</td>
</tr>
</tbody>
</table>
Keycodes

A keycode is also generated as part of the customer software order. The keycode is customized based on the following parameters:

- a specific release and issue of X11 software
- a specific software generic (representing the combination of the system type and Call Processor type)
- a specific set of feature packages and ISM limits
- a specific set of security devices

The keycode is an electronic file that resides on a diskette or your PC and is installed using Overlay 143 or the Meridian 1 Software Installation Tool.

A new keycode is required when converting software releases, adding features, modifying ISM limits, and when replacing a security device. During the software installation process, you will be prompted to install a keycode diskette.

In addition to receiving a keycode diskette from Nortel Networks, you can download a keycode from the Distributor Keycode Server to your PC hard disk and copy it to a standard 2 MB floppy diskette.
Guidelines for using keycodes

The keycode determines which features a system may access and what Incremental Software Management (ISM) limits the system has, so it is critical for customers and distributors to observe the guidelines outlined in Table 3 when working with keycodes.

Table 3

Keycode guidelines

<table>
<thead>
<tr>
<th>Guidelines</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remove the following from the customer site:</td>
</tr>
<tr>
<td>Remove old keycodes for the current software release and issue, which enable fewer features and lower ISM limits.</td>
</tr>
<tr>
<td>Remove old keycodes for a previous software release or issue, and the old CD-ROM disks, as soon as the system has proven stable on the new release or issue.</td>
</tr>
<tr>
<td>Delete the old keycodes from distributor archives as soon as the system has proven stable with the new features enabled by the new keycode.</td>
</tr>
<tr>
<td>Delete old keycodes for previous software releases periodically when it is clear they are no longer needed for technical support purposes, and discard old CD-ROM disks when a given release or issue is no longer supported.</td>
</tr>
<tr>
<td>Always use the LD 143 “KDIF” command first to compare the current active keycode with the new keycode on a floppy disk in floppy drive f0 or f1 or on the hard disk, and make sure that the new keycode will not disable features or reduce ISM limits, before using the LD 143 “KNEW” command to copy the new keycode to the pending keycode. Note that the pending keycode will become the active keycode after the next cold start.</td>
</tr>
<tr>
<td>Never install any keycode using the Install Program diskette Install Menu or Tools Menu without first comparing it with the current active keycode as described above, unless the system is out of service and cannot come up into service due to a suspected bad keycode.</td>
</tr>
<tr>
<td>Avoid installing a keycode without knowing what it will do to a customer's features and ISM limits when it becomes active following the next cold start.</td>
</tr>
<tr>
<td>In LD 22, LAPW passwords should be configured to deny access to LD 143 keycode change commands “KNEW, KOUT, KRVR, KMAN, and KUPL,” except for technicians who are authorized to install new keycodes remotely and to change system configuration for technical support purposes. All LAPW passwords with access to LD 143 always have access to the keycode display commands “KDIF, KSHO, and KSTT.”</td>
</tr>
</tbody>
</table>
Feature expansion

With previous multi drive units, feature expansion and Incremental Software Modification (ISM) required shipment and installation of customized software and new data cartridge. With IODU/C, feature expansion and ISM only requires installation of a new keycode.

The keycode can be delivered on diskette or transferred electronically using the commands in LD 143 (electronic file transfer is supported for feature expansion and ISM modification only). Refer to “Key Management, LD 143” in this document for feature expansion procedures.

Software upissues

A new Install Program and Keycode diskette are required to perform software upissues. Each keycode is release and issue dependant.

Database transfer

Database transfer is the process of transferring a 4 MB system database to a 2 MB format that is compatible with the IODU/C card.

Typically, database transfer is performed in conjunction with a system upgrade. Refer to Hardware Upgrade Procedures (553-3001-258) for complete system upgrade procedures, or “Database Transfer” for information on 2 MB to 4 MB transfer procedures.

For systems equipped with IOP/CMDU or separate IOP and CMDU cards, the database is transferred from 4 MB to 2 MB floppy media using the Database Transfer Utility diskette. The Database Transfer Utility diskette is included in the upgrade package and is installed in the IOP/CMDU card.

For systems equipped with MDU or SMDU cards, the database can be transferred using two different methods:

- transferring the database using the Database Transfer Utility (this requires an “interim” IOP/CMDU card during the database transfer)
- cabling the SMDU or MDU to the IODU/C card and downloading the database to the IODU/C
How does the IODU/C card differ from the IOP/CMDU card?

The primary differences between the IODU/C and IOP/CMDU cards are listed in Table 4.

Table 4
IODU/C and IOP/CMDU differences

<table>
<thead>
<tr>
<th>Software installation</th>
<th>IODU/C</th>
<th>IOP/CMDU</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Reads generic software from a CD-ROM</td>
<td>Reads customized software from a 4 MB floppy diskette media</td>
</tr>
<tr>
<td></td>
<td>For redundant systems, software is installed on Core 1 and copied to Core 0.</td>
<td>For redundant systems, software is installed on both Cores.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Feature activation</th>
<th>IODU/C</th>
<th>IOP/CMDU</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Controlled by a security device and keycode</td>
<td>Controlled by a security cartridge</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Security device replacement</th>
<th>IODU/C</th>
<th>IOP/CMDU</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The security device on the IODU/C is replaced only in the unlikely event of failure</td>
<td>The security cartridge is replaced with each software order</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Feature expansion/ISM limit change</th>
<th>IODU/C</th>
<th>IOP/CMDU</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Requires new keycode only.</td>
<td>Requires shipment and reload of custom software and security cartridge.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>2MB floppy media</th>
<th>IODU/C</th>
<th>IOP/CMDU</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Supports 2 MB floppy media. For large databases, the IODU/C supports multiple floppy diskette backup.</td>
<td>Supports 4 MB floppy media.</td>
</tr>
</tbody>
</table>
Installing the IODU/C card

This procedure describes how to replace NT5D20 IOP/CMDU or NT6D63 IOP and NT6D64 CMDU cards with NT5D61 IODU/C cards on Options 51C, 61C, 81, or 81C, and install X11 software.

Note: This procedure can also be used to install both an IODU/C card and new NT9D19, NT5D10, or NT5D03 Call Processor Card.

IOP/CMDU or IOP and CMDU cards cannot be mixed with IODU/C cards in the same system.
Table 5
IODU/C card installation overview

<table>
<thead>
<tr>
<th>Major task</th>
<th>For more information...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Perform a data dump</td>
<td>see page 21</td>
</tr>
<tr>
<td>Split the Cores*</td>
<td>see page 22</td>
</tr>
<tr>
<td>Transfer the database to IODU/C 2 MB</td>
<td>see page 23</td>
</tr>
<tr>
<td>Upgrade Core 1*</td>
<td>see page 24</td>
</tr>
<tr>
<td>Switch call processing from Core 0 to Core 1*</td>
<td>see page 28</td>
</tr>
<tr>
<td>Upgrade Core 0</td>
<td>see page 29</td>
</tr>
<tr>
<td>Return the system the redundant mode*</td>
<td>see page 33</td>
</tr>
<tr>
<td>Test CPUs and CNIs</td>
<td>see page 33</td>
</tr>
<tr>
<td>Clear alarms</td>
<td>see page 33</td>
</tr>
<tr>
<td>Synchronize the hard disks*</td>
<td>see page 33</td>
</tr>
</tbody>
</table>

*This task does not apply to Option 51C systems.

CAUTION
At some point in this procedure, you will be required to warm start your system, causing a momentary interruption in call processing.

CAUTION
To avoid damaging equipment from electrostatic discharge, wear a properly connected anti-static wrist strap when working on or near Meridian 1 equipment.

Installation procedures for Options 61C, 81, and 81C

Note: Option 51C procedures begin on page 35.
To perform this procedure the following is required:

- a CP Install Program diskette specific to your CP type (68060, 68060E, 68040, 68030)
- a CD-ROM containing generic system software
- one Keycode diskette
- Database diskette(s)
- two NT5D61 IODU/C cards
- two IODU/C Security Devices
- a Database Transfer Utility diskette to archive the IOP/CMDU database on 2MB floppy diskettes.

Note: The diskettes in the Software Install Kit are write protected. Ensure that you unprotect the disks before installation.

Perform a data dump

Before starting this procedure, make a backup copy of the customer database on a 4MB diskette using the data dump routine:

1. Log into the system
2. Load the Equipment Data Dump Program (LD 43).
   
   LD 43 to load the program

3. When “EDD000” appears on the terminal, enter
   
   EDD to begin the data dump

4. When “DATADUMP COMPLETE” and “DATABASE BACKUP COMPLETE” appear on the terminal, enter
   
   **** to exit the program

CAUTION

If the data dump is not successful, do not continue; contact your technical support organization. A data dump problem must be corrected before proceeding.
To access the Core during the replacement procedure, connect a terminal to the J25 port on the I/O panel in the Core 1 of the Core Module or Core/Network Module. To communicate with the processor, you must use the following settings on the terminal:

**9600 baud, 7 data, space parity, 1 stop bit, full duplex, XOFF**

If you are using only one terminal or a switch box, switch the connection from Core to Core as needed.

**Split the cores**

1. Verify that the disk drives are synchronized:
   - **LD 137** to load the program
   - **STAT** to get the status of the disk drives

   If the disks are synchronized, proceed with step 2. If they are not synchronized, execute the SYNC command:
   - **SYNC** to synchronize the drives
   - **** to exit the program

2. Verify that clock controller 0 is active. If it is not, switch to clock controller 0:
   - **LD 60** to load the program
   - **SSCK 0** to get the status of clock controller 0
   - **SWCK** to switch to clock controller 0 (if necessary)
   - **** to exit the program

3. Verify that Core 0 is the active Core:
   - **LD 135** to load the program
   - **STAT CPU** to check CPU status
   - **TEST CPU** to test the CPU

   If Core 0 is active, proceed with step 4. If Core 0 is not the active CPU, swap Cores and verify again:
   - **SCPU** to swap CPUs
   - **STAT CPU** to check CPU status
4 Verify that CMDU 0 is active. You may need to switch CMDUs.
   
   **LD 137** to load the program
   **STAT** Get the status of CMDU and IOP.
   **SWAP** Switch CMDUs (if necessary).

5 Set the MAINT/NORM switch on the CP card in Core 0 to MAINT.

6 Set the ENB/DIS switch on all CNI cards in Core 1 to DIS.

7 Insert the Database Transfer Utility diskette which corresponds to your source (existing) Call Processor card into the IOP/CMDU or CMDU in Core 1.

8 Perform the following three steps in uninterrupted sequence:
   
   — press and hold the MAN RST button on the CP card in Core 1
   — set the MAINT/NORM switch on the CP card in Core 1 to MAINT
   — release the MAN RST button

Transfer the database to 2MB

1 When the NT Logo Screen appears on the terminal, the Database Transfer Utility has loaded. Press <CR> to continue

   **CAUTION**
   When using the Database Transfer Utility, only select options <t> Tools Menu from the Install menu and <s> To archive existing database from the Tools menu. Selecting any other options can result in operating system corruption.

2 At the Database Transfer Utility Install menu, select <t> to go to the Tools Menu.

3 At the Database Transfer Utility Tools menu select <s> to archive the database on one or more 2MB diskettes.

4 When the number of 2MB diskettes required is displayed, select <a>.

5 When prompted, insert the first database diskette and select <a> to continue.
6 The message “Database backup complete!” will be displayed, and the Tools menu will reappear.

7 Remove the 2MB diskette from the IOP/CMDU, but do not reboot the system at this point.

Upgrade Core 1

1 In systems equipped with an NT6D63 IOP and NT6D64 CMDU, perform the following steps to remove these cards:

   — To remove the IOP:
     • Set the ENB/DIS switch to DIS on the IOP being upgraded.
     • Remove the IOP.

   — To remove the CMDU:
     • If there is a floppy disk in the CMDU you are upgrading, remove the floppy disk.
     • Set the ENB/DIS switch to DIS on the front of the CMDU.
     • Wait at least 10 seconds, then unhook the locking devices on the CMDU and gently pull the unit out of the card cage.

2 In system equipped with an NT5D20 IOP/CMDU, perform the following steps to remove this card:

   • Set the ENB/DIS switch on the IOP/CMDU to DIS.
   • Unhook the locking devices and remove the IOP/CMDU.

3 Locate the round 1/2” diameter IODU/C Security Device.

4 Make sure that the 8-digit code (the NT SDID) on the Keycode diskette matches the 8-digit code on the Security Device.

5 With the Nortel Networks side facing upward, slide the Security Device between the black round security device holder on the top right hand corner of the IODU/C card and the holder clip (see Figure 1). Do not bend the clip more than necessary when inserting the Security Device. Ensure that the Security Device is securely in place.
Note: The next step installs the NT5D61AA vintage IODU/C card in Core 1. The AA vintage card has a CD-ROM drive which is required for software installation on Core 1.

6 Ensure that the ENB/DIS switch on the NT5D61AA IODU/C you will install is set to DIS.

7 Insert the NT5D61AA IODU/C into the following slots:
   • For NT5D21 Core/Net Modules, insert the IODU/C in slots 17, 18, and 19.
   • For NT9D11 Core/Network Modules and NT6D60 Core Modules, insert the IODU/C into slots 16, 17, and 18.
8 Lock the locking devices by pushing them gently towards the faceplate. Set the ENB/DIS switch to ENB.

A blinking letter “E” and number “5” displayed indicates that a failure occurred. In that case, reseat the Security Device in its holder and reinsert the card.

9 Install the CD-ROM into the CD drive:
• press the button on the CD-ROM drive to open the CD-ROM disk holder
• place the CD-ROM disk into the holder with the disk label showing
• use the four tabs to secure the CD-ROM drive
• press the button again to close the CD-ROM disk holder (don’t push the holder in by hand)

10 Insert the CP Install disk that corresponds with your CP card type into the IODU/C in Core/Net 1. (If you are also upgrading your CP card during this procedure, install the CP Install disk that corresponds with your target CP card type.)

11 If you are upgrading your CP card:
• Ensure that the current CP card in Core/Net 1 is set to MAINT.
• Remove the current CP card and place it in a static bag and box.
• Ensure that the CP card you are upgrading to is set to MAINT.
• Insert the new CP card into the vacated slot and hook the locking devices.

12 In Core/Net 1, perform the following three steps in uninterrupted sequence:
• press and hold the MAN RST button on the CP card
• verify that the MAINT/NORM switch on the CP card to MAINT
• release the MAN RST button

A sysload will begin (cold start). Wait for the Main Menu to appear on the terminal before proceeding.

13 Press <CR> to continue.
14 Log into the system and enter the time and date, when prompted.

15 Initiate the database installation by selecting the following command from the menu:

\[ \text{<u>} \quad \text{to Install menu} \]

16 Remove the CP Install Program diskette and insert the Keycode diskette, when prompted.

\[ \text{<a>} \quad \text{to continue with keycode validation} \]
\[ \text{<y>} \quad \text{to confirm that the keycode matches the CD-ROM release} \]

17 When the Install Menu is displayed, select the following options in sequence when you are prompted to do so

\[ \text{<b>} \quad \text{to install software, database, CP-BOOT ROM, and IOP-ROM} \]
\[ \text{<a>} \quad \text{to verify that the CD-ROM is now in drive} \]

The Installation Status Summary screen appears that lists the options to be installed.

\[ \text{<y>} \quad \text{Yes, start Installation} \]
\[ \text{<a>} \quad \text{Continue with Upgrade} \]

When the ROM installation screen appears, select the following prompts in sequence:

\[ \text{<a>} \quad \text{Continue with ROM Upgrade} \]

The following message appears:

Software Release XXXX was installed successfully on Core 1.
All files were copied from CDROM to the hard disk.
Please press <CR> to when ready...

\[ \text{<a>} \quad \text{Continue with ROM upgrade} \]
\[ \text{<a>} \quad \text{Yes, start Installation} \]
\[ \text{<a>} \quad \text{Continue with ROM upgrade} \]

When the Installation Status Summary screen appears, press
<CR> when ready...

When the INSTALL MENU appears:

\[ \text{<d>} \quad \text{To install Database only} \]

When the database installation screen appears, insert the first
2 MB database diskettes in the IODU/C.
Switch call processing from Core 0 to Core 1

CAUTION
Call processing will be interrupted
Perform the next steps carefully. This is the point at which your service is interrupted. Calls in progress will be interrupted, especially if Peripheral Software Download takes place.

Perform the next 4 steps (steps 1-4) in succession. Call processing will be switched from Core 0 to Core 1.

1. In Core 0, set the DIS/ENB faceplate switch on the IOP or IOP/CMDU card to DIS.

2. In Core 0, disable the NT6D65 CNI cards by setting the ENB/DIS faceplate switches to DIS.
3  In Core 1, enable the NT6D65 CNI cards by setting the ENB/DIS faceplate to ENB.

4  In Core 1, press the MAN INT button.

After the system initialization has finished (INI messages are no longer displayed on the system terminal), check for dial tone on a telephone set.

5  Following a successful dial tone test, perform the following basic sanity tests:
   • Make sure calls can be placed
   • Check for error messages, line noise, chatter, or other problems. Track sources and resolve problems as necessary.

Upgrade Core 0

1  Move the terminal cable to the J25 port on the I/O panel of the other Core or Core/Network Module, and continue with the following steps for the replacement of the second IOP/CMDU card.

2  In systems equipped with an NT6D63 IOP and NT6D64 CMDU, perform the following two steps to remove these cards:
   — To remove the IOP:
     • Set the ENB/DIS switch to DIS on the IOP being upgraded.
     • Remove the IOP.
   — To remove the CMDU:
     • If there is a floppy disk in the CMDU you are upgrading, remove the floppy disk.
     • Set the power switch on the front of the CMDU, if present, to OFF (down).
     • Wait at least 10 seconds, then unhook the locking devices on the CMDU and gently pull the unit out of the card cage.
     • Continue with step 4.
3 **In system equipped with an NT5D20 IOP/CMDU**, perform the following steps to remove this card:
   - Set the ENB/DIS switch on the IOP/CMDU to DIS.
   - Unhook the locking devices and remove the IOP/CMDU.
   - Continue with step 4.

4 Locate the round 1/2” diameter IODU/C Security Device.

5 Make sure that the 8-digit code (the NT SDID) on the Keycode diskette matches the 8-digit code on the Security Device.

6 With the Nortel Networks side facing upward, slide the Security Device between the black round security device holder on the top right hand corner of the IODU/C card and the holder clip. Do not bend the clip more than necessary when inserting the Security Device. Ensure that the Security Device is securely in place.

7 Ensure that the ENB/DIS switch on the IODU/C you will install is set to DIS.

8 Insert the IODU/C into the following slots:
   - For NT5D21 Core/Net Modules, insert the IODU/C in slots 17, 18, and 19.
   - For NT9D11 Core/Network Modules and NT6D60 Core Modules, insert the IODU/C into slots 16, 17, and 18.

9 Lock the locking devices by pushing them gently towards the faceplate. Set the ENB/DIS switch to ENB.

   A blinking letter “E” and number “5” displayed indicates that a failure occurred. In that case, reseat the Security Device in its holder and reinsert the card.

10 Insert the CP Install Program diskette that corresponds to your target CP type into the IODU/C on Core 0.

11 Ensure that the current CP card is set to MAINT. Remove the current CP card and put it in a static bag and box.

12 Ensure the NORM/MAINT switch is set to MAINT, and insert the Call Processor replacement card into the vacated slot and hook the locking devices.
13 Press the MAN RST button on the CP card in Core/Net 0 to reboot the system and start the Software Installation Tool. (The terminal displays SYSLOAD messages during file loading. When SYSLOAD is completed, the NT logo appears.)

14 When the NT logo appears, press <CR> to continue.

15 Log into the system.

16 Enter the time and date, when prompted.

17 Initiate the installation by selecting the following prompt from the menu:
   <cr> <u> to Install menu

18 Remove the Install Utility diskette and insert the Keycode diskette, when prompted.
   <a> continue with keycode validation
   <y> to confirm that keycode matches CD-ROM release

19 Remove the Keycode diskette and re-insert the Install Utility diskette into the IODU/C floppy drive in Core/Net 0.

20 When the Install Menu appears, select the following options in sequence to copy the software from Core/Net 1 to Core/Net 0, install CP-software, ROMs, and transfer the database to the redundant disk:
   <o> to copy system software from the other Core/Net
   <a> to continue
   <a> to copy /p partition from Core 1 to Core 0

When the software has copied successfully, you must install CP-software from the hard disk to Flash EEPROM, and install CP-BOOT ROM.
   <CR> press <CR> when you are ready to continue
   <a> to continue with ROM upgrade
   <y> to start installing CP-BOOT ROM
   <a> to continue with ROM upgrade.

When the installation is complete, the Installation Status Summary screen appears.
   <CR> to return to the Install Menu
When the Install Menu appears, install IOP-ROM:

<CR> to install IOP-ROM only

When the Installation Status Summary screen appears:

<y> to start installation
<y> to continue installing IOP-ROM
<a> to continue with ROM upgrade

When the installation is complete, the Installation Status Summary screen appears.

<CR> to return to the Install Menu

When the Install Menu appears, install the database:

<d> to install database only

When the Installation Status Summary screen appears:

<y> to start installation
<a> to continue transferring the database from the redundant disk

When the Installation Status Summary screen appears:

<CR> to return to the Install Menu

When the Install Menu appears, remove any diskettes in the floppy before rebooting the system:

<q> to quit
<y> to confirm quit
<a> to reboot the system

Wait for “DONE” and then “INI” messages to be displayed before continuing.
Return the system to redundant mode

To place the system back in the redundant (normal) mode with automatic switchover capability, perform the following steps in uninterrupted sequence:

- In Core 0, enable the NT6D65 CNI cards by setting the ENB/DIS faceplate switches to ENB.
- In Core 0, press and release the MAN RST button on the CP card.
- When SYS700 messages appear on the inactive CP LCD display, set the CP NORM/MAINT switch to NORM in Core 0.

An HWI534 message on the active Core will be displayed indicating that memory synchronization has begun. An HWI533 message on the active Core indicates that memory synchronization is complete.

- In Core 1, set the NORM/MAINT faceplate switch to NORM.

Complete the upgrade

1. Perform a redundancy sanity test using the following sequence:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LD 135</td>
<td>Get status of CNI cards.</td>
</tr>
<tr>
<td>STAT CNI</td>
<td>Get status of CNI cards.</td>
</tr>
<tr>
<td>STAT CPU</td>
<td>Get status of CPU and memories.</td>
</tr>
<tr>
<td>TEST CNI</td>
<td>Test each inactive CNI card.</td>
</tr>
<tr>
<td>core slot</td>
<td></td>
</tr>
</tbody>
</table>

   **Note:** Testing the CP and CNI cards and synchronizing memory takes up to 20 minutes for each test. When the CP test is complete, the memories are automatically synchronized.

2. Switch Cores, and test the other side.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TEST CPU</td>
<td>Test the standby (inactive) Core.</td>
</tr>
<tr>
<td>SCP</td>
<td>Switch Cores.</td>
</tr>
<tr>
<td>TEST CNI</td>
<td>Test each inactive CNI card.</td>
</tr>
<tr>
<td>core slot</td>
<td></td>
</tr>
</tbody>
</table>

   **Note:** Testing the CP cards can take up to 20 minutes for each test. When the test is complete, the memories are automatically synchronized.

3. Clear the display, and minor alarms on both Cores.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CDSP</td>
<td>Clear the displays on the Cores.</td>
</tr>
<tr>
<td>CMAJ</td>
<td>Clear major alarm.</td>
</tr>
<tr>
<td>CMIN ALL</td>
<td>Clear minor alarm.</td>
</tr>
</tbody>
</table>

   **Note:**
4 Get the status of the Cores, CNIs, and memories
   STAT CPU Get the status of both Cores.
   STAT CNI Get the status of all configured CNIs and memories.

5 Load LD 137 and synchronize hard disks. Synchronization may take up to 50 minutes. To be sure that the contents of IODU/C 1 are copied to IODU/C 0, verify that IODU/C 0 is disabled.
   LD 137
   STAT Get the status of both IODU/Cs and redundancy.
   SYNC Enter “Yes” to synchronize disks. Wait until the memory synchronization successfully completes before continuing.

6 Get the status of the IODU/Cs and be sure IODU/C 0 is active. Switch if necessary.
   LD 137
   STAT Get the status of the IODU/Cs.
   SWAP Switch IODU/C (if necessary).
   STAT CMDU Get the status of the IODU/Cs. Be sure the same IODU/C and CPU are active.

7 Insert the database diskette into both IODU/Cs for backup. Load LD 43 and datadump. This creates a backup on the floppy disk in the active IODU/C.
   LD 43
   EDD Data dump complete (or database backup complete) is printed when the data dump has been successfully completed. Investigate any EDD messages. Refer to X11 Administration (553-3001-311).

8 Evaluate the number of call registers and telephone buffers that are configured for the system. Refer to Capacity Engineering (553-3001-149).

The IODU/C installation is complete.
Installation procedure for Option 51C systems

WARNING
Performing this procedure will disrupt system operation. If possible, schedule the replacement at the lowest traffic time.

To perform this procedure, the following is required:

- an Install Program diskette specific to your CP type
- a CD-ROM containing system software
- Keycode diskette
- Database diskette(s)
- one NT5D61AA IODU/C card
- one IODU/C Security Device
- a Database Transfer Utility to archive the IOP/CMDU or CMDU database on 2MB floppy diskettes.

Note: If you are also installing a new Call Processor card, then one Call Processor card is required.

Perform a data dump

Before starting this procedure, make a backup copy of the customer database on a 4MB diskette using the data dump routine:

1 Log into the system
2 Load the Equipment Data Dump Program (LD 43).
   LD 43 to load the program
3 When “EDD000” appears on the terminal, enter
   EDD to begin the data dump
4 When “DATADUMP COMPLETE” and “DATABASE BACKUP COMPLETE” appear on the terminal, enter
   **** to exit the program
To access the Core during the replacement procedure, connect a terminal to the J25 port on the I/O panel in the Core/Network Module. To communicate with the processor, you must use the following settings on the terminal:

9600 baud, 7 data, space parity, 1 stop bit, full duplex,

**Transfer the database to 2 MB**

1. Insert the Database Transfer Utility diskette which corresponds to your source (existing) Call Processor card into the IOP/CMDU or CMDU.
2. Press the MAN RST button on the CP card.
3. When the NT Logo Screen appears on the terminal, the Database Transfer Utility has loaded. Press <CR> to continue.
4. At the Database Transfer Utility Install menu, select <t> to go to the Tools Menu.
5. At the Database Transfer Utility Tools menu select <s> to archive the database on one or more 2MB diskettes.
6. When the number of 2MB diskettes required is displayed, select <a>.
7. Insert the first database diskette and select <a> to continue.
8. The message “Database backup complete!” will be displayed, and the Tools menu will reappear.

**CAUTION**

If the data dump is not successful, do not continue; contact your technical support organization. A data dump problem must be corrected before proceeding.

**CAUTION**

When using the Database Transfer Utility, only select options <t> Tools Menu from the Install Menu and <s> To archive existing database from the Tools menu. Selecting any other options can result in operating system corruption.
Remove the 2MB diskette from the IOP/CMDU, but do not reboot the system at this point.

Install the IODU/C card

1. Set the ENB/DIS switch on the IOP/CMDU to DIS.
2. Unhook the locking devices and remove the IOP/CMDU.
3. Locate the round 1/2” diameter IODU/C replacement Security Device.
4. Make sure the 8-digit code (the NT SDID) on the Keycode diskette matches the 8-digit code on the Security Device.
5. With the Nortel Networks side facing upward, slide the Security Device between the black round security device holder on the top right hand corner of the IODU/C card and the holder clip. Do not bend the clip more than necessary when inserting the Security Device. Ensure that the Security Device is securely in place.
6. Ensure that the ENB/DIS switch on the IODU/C you will install is set to DIS.
7. Insert the IODU/C into slots 17, 18, and 19 in the NT5D21 Core/Net Module or slots 16, 17, and 18 in the NT9D11 Core/Network Module.
8. Lock the locking devices by pushing them gently towards the faceplate. Set the ENB/DIS switch to ENB.
   A blinking letter “E” and number “5” displayed indicates that a failure occurred. In that case, reseat the Security Device in its holder and reinsert the card.
9. Insert the Install Program diskette that corresponds to your CP-type into the IODU/C.
10 Install the CD-ROM disk into the CD-ROM drive. To install the CD-ROM:
   • press the button on the CD-ROM drive to open the CD-ROM disk holder
   • place the CD-ROM disk into the holder with the disk label showing
   • use the tabs to secure the CD-ROM in the disk holder
   • press the button again to close the CD-ROM disk holder (don’t push the holder in by hand)

11 Ensure that the current CP card is set to MAINT. Remove the current CP card and put it in a static bag and box.

12 Ensure the NORM/MAINT switch is set to MAINT, and insert the Call Processor replacement card into the vacated slot and hook the locking devices.

A sysload will begin (cold start). Wait for the Main Menu to appear on the terminal before proceeding.

13 Press <CR> to continue.

14 Log into the system and enter the time and date, when prompted.
15 Initiate the database installation by selecting the following command from the menu:
   <u> to Install menu

16 Remove the CP Install Program diskette and insert the Keycode diskette, when prompted.
   <a> to continue with keycode validation
   <y> to confirm that the keycode matches the CD-ROM release

17 When the Install Menu is displayed, select the following options in sequence when you are prompted to do so
   <h> to install software, database, CP-BOOT ROM, and IOP-ROM
   <a> to verify that the CD-ROM is now in drive
The Installation Status Summary screen appears that lists the options to be installed.
   <y> Yes, start Installation
   <a> Continue with Upgrade
When the ROM installation screen appears, select the following prompts in sequence:
   <a> Continue with ROM Upgrade
The following message appears:
Software Release XXXX was installed successfully. All files were copied from CDROM to the hard disk.
Please press <CR> to when ready...
   <a> Continue with ROM upgrade
   <a> Yes, start Installation
   <a> Continue with ROM upgrade
When the Installation Status Summary screen appears, press <CR> when ready...
When the INSTALL MENU appears:
   <d> To install Database only
When the database installation screen appears, insert the first 2 MB database diskettes in the IODU/C.
   <a> to install the customer database
Installing the IODU/C card

Complete the upgrade

1 Log into the system.

2 Verify CPU and CNI functionality:
   
   LD 135 to load the program
   STAT CPU to check the CPU status
   STAT CNI to verify CNI functionality
   **** to exit the program

   Make a backup of the customer database on 2MB diskettes:

   3 Load the Equipment Data Dump Program (LD 43).
      LD 43 to load the program

   4 When “EDD000” appears on the terminal, enter
      EDD to begin the data dump
5 When “DATADUMP COMPLETE” and “DATABASE BACKUP COMPLETE” appear on the terminal, enter
**** to exit the program

<table>
<thead>
<tr>
<th>CAUTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>If the data dump is not successful, do not continue; contact your technical support organization. A data dump problem must be corrected before proceeding.</td>
</tr>
</tbody>
</table>

6 Evaluate the number of call registers and telephone buffers that are configured for the system. Refer to Capacity Engineering (553-3001-149).

The installation is complete.
Software conversion

CAUTION
To avoid damaging equipment from electrostatic discharge, wear a properly connected anti-static wrist strap when working on or near Meridian 1 equipment.

The procedures in this section can be used to:

- convert software from one X11 release to another
- perform a software upissue

A new keycode is required to convert software from one X11 release to another and perform a software upissue.

Note: For information on adding features and modifying ISM (Incremental Software Management) limits, refer to page 63.
Parallel reload Options 61C/81/81C

Note: This procedure does not include instructions for installing new IODU/C cards. To use this procedure, your system must already be equipped with IODU/C cards.

Use the parallel reload procedure to install software on a dual-CPU system.

Table 6 summarizes the required tasks to perform this procedure.

Table 6
Options 61C, 81, 81C parallel reload overview

<table>
<thead>
<tr>
<th>Task</th>
<th>For more information...</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Verify memory</td>
<td>page 45</td>
</tr>
<tr>
<td>2. Perform a data dump</td>
<td>page 45</td>
</tr>
<tr>
<td>3. STAT the hardware</td>
<td>page 45</td>
</tr>
<tr>
<td>4. Split the Cores</td>
<td>page 46</td>
</tr>
<tr>
<td>5. Install software on Core 1</td>
<td>page 47</td>
</tr>
<tr>
<td>6. Check for peripheral software download</td>
<td>page 49</td>
</tr>
<tr>
<td>7. Switch call processing from Core 0 to Core 1</td>
<td>page 50</td>
</tr>
<tr>
<td>8. Test Core 1</td>
<td>page 50</td>
</tr>
<tr>
<td>9. Install software on Core 0</td>
<td>page 51</td>
</tr>
<tr>
<td>10. Exit split mode</td>
<td>page 53</td>
</tr>
<tr>
<td>11. Test Core 0 and 1</td>
<td>page 53</td>
</tr>
<tr>
<td>12. Synchronize the hard disks</td>
<td>page 54</td>
</tr>
<tr>
<td>13. Perform a data dump</td>
<td>page 55</td>
</tr>
</tbody>
</table>
Verify memory

Determine whether your system requires additional memory to install new software. Refer to the General Release Bulletin or *Software Conversion Procedures* (553-2001-320) for memory requirements.

Perform a data dump

1. Load the Equipment Data Dump Program (LD 43). At the prompt, enter LD 43 to load the program.
2. When “EDD000” appears on the terminal, enter EDD to begin the data dump.
3. When “DATABASE BACKUP COMPLETE” or “DATADUMP COMPLETE” appears on the terminal, enter **** to exit the program.

**CAUTION**

If the data dump is not successful, do not continue; contact your technical support organization. A data dump problem must be corrected before proceeding.

STAT the hardware

1. Load LD 137 and get status of the hard disks.

   **Note:** Be sure the hard disks are synchronized. If not, synchronize before proceeding.

   LD 137
   STAT Get the status of the hard disks
   SYNC Synchronize hard disks if necessary.
   Synchronization may take up to 50 minutes
   **** exit program
Load LD 135 and get status of the CPs, CNIs and memories.

2  LD 135
   STAT CPU     Get the status of both CPs and memory
   STAT CNI     Get the status of all configured CNIs

3  Test the standby (inactive) CP. Then switch CPs, and test again.
   TEST CPU     Test standby (inactive) CP
   Wait until the terminal returns a complete test message. The message “HWI533 or HWI534” does not mean the test has completed!
   SCPU          Switch CPs
   TEST CPU     Test the standby (inactive) CP

   **Note:** Testing the CPs can take up to 20 minutes for each test. When the test is complete, the memories are automatically synchronized.

### Split the Cores

Parallel reloads can be done from either CPU. For the purposes of this document, we begin with CPU 0.

1  Be sure CP 0 is active and CP1 is standby. You may need to switch CPs again:
   STAT CPU
   ****     exit program

2  Verify that IODU/C 0 is active. You may need to switch IODU/Cs.
   LD 137
   STAT      Get the status of IODU/C
   SWAP      Switch IODU/Cs if necessary
   ****      exit program

3  Connect a terminal to the CPSI port in Core 1 to J25 of the I/O panel at the back of the Core. Be sure it is configured as follows. The recommended baud rate is 9600, to be the same as the CPSI port.

   7 data bits, 1 stop bit, Space parity, Full duplex, XON protocol
4 Place CP 0 in Maintenance by setting the MAINT/NORM switch to MAINT.

5 In Core 1, disable the NT6D65 Core to Network Interface (CNI) cards by setting the ENB/DIS faceplate switches to DIS.

Install software on Core 1

1 Place the CP Install disk that corresponds with the installed CP card type into the IODU/C in Core/Net 1.

2 Install the CD-ROM into the CD drive:
   • press the button on the CD-ROM drive to open the CD-ROM disk holder
   • place the CD-ROM disk into the holder with the disk label showing
   • use the four tabs to secure the CD-ROM drive
   • press the button again to close the CD-ROM disk holder (don’t push the holder in by hand)

3 In Core/Net 1, perform the following three steps in uninterrupted sequence:
   • press and hold the MAN RST button on the CP card
   • set the MAINT/NORM switch on the CP card to MAINT
   • release the MAN RST button

A sysload will begin (cold start). Wait for the Main Menu to appear on the terminal before proceeding.

Note 1: If the CD-ROM is not in the CD drive of the IODU/C, the installation procedure will not continue. Please insert the CD-ROM into the drive to continue.

Note 2: If a problem is detected during the system verification, Install stops, prints an error message, and aborts the installation. If the verification is not successful, do not continue; contact your technical support organization.

4 Press <CR> to continue.

5 Log into the system and enter the time and date, when prompted.
6  Initiate the database installation by selecting the following command from the menu:
   <u> to Install menu

7  Remove the CP Install Program diskette and insert the Keycode diskette, when prompted.
   <a> to continue with keycode validation
   <y> to confirm that the keycode matches the CD-ROM release

8  When the Install Menu is displayed, select the following options in sequence when you are prompted to do so
   <b> to install software, database, CP-BOOT ROM, and IOP-ROM
   <a> to verify that the CD-ROM is now in drive
   The Installation Status Summary screen appears that lists the options to be installed.
   <y> Yes, start Installation
   <a> Continue with Upgrade
   When the ROM installation screen appears, select the following prompts in sequence:
   <a> Continue with ROM Upgrade
   The following message appears:
   Software Release XXXX was installed successfully on Core 1. All files were copied from CDROM to the hard disk.
   Please press <CR> to when ready...
   <a> Continue with ROM upgrade
   <a> Yes, start Installation
   <a> Continue with ROM upgrade
   When the Installation Status Summary screen appears, press <CR> when ready...
   When the INSTALL MENU appears:
   <d> To install Database only
   When the database installation screen appears, insert the first 2 MB database diskettes in the IODU/C.
   <a> to install the customer database
If the system fails to load, or system messages indicate data corruption, back out of the parallel reload process by performing the steps in “Backing out of the parallel reload on the Option 61C/81/81C” on page 55.

1. Check for peripheral software download

   Load LD 22 and print Target peripheral software version. The Source peripheral software version was printed during the pre-conversion procedure. If there is a difference between the Source and Target peripheral software version, a forced download will occur during initialization when coming out of parallel reload. System initialization will take longer and established calls on IPE will be dropped.

   LD 22
   
   REQUEST: PRT
   TYPE: PSWV
   ****
   exit program
2. Switch call processing to Core 1

CAUTION
Call Processing will be interrupted! Perform these next steps carefully. This is the point at which your service is interrupted. Calls in process will be interrupted, especially if Peripheral Software Download takes place. Some calls may be dropped.

Perform the next four steps in succession. Call processing will be switched from Core 0 to Core 1.

1. In Core 0, set the DIS/ENB faceplate switch on the IODU/C card to DIS.
2. In Core 0, disable the NT6D65 CNI cards by setting the ENB/DIS faceplate switches to DIS.
3. In Core 1, enable the NT6D65 CNI cards by setting the ENB/DIS faceplate to ENB.
4. In Core 1, press the MAN INT button.

Note: Call processing is now switched from Core 0 to Core 1.

3. Test Core 1

1. Test Call Processing. This includes, but is not limited to the following:
   - Check for dial tone.
   - Make internal, external, and network calls.
   - Check attendant console activity.
   - Check DID trunks.
   - Check any auxiliary processors.

Note: From this point forward you will be upgrading Core 0 with new software.
4. Install software on Core 0

1. Move the CPSI port cable from J25 on Core/Net 1 to J25 on Core/Net 0.
2. Set the IODU/C faceplate switch to ENB.
3. Insert the CP Install diskette into Core/Net 0.
4. Press the MAN RST button on the CP card in Core/Net 0 to reboot the system and start the Software Installation Tool. (The terminal displays SYSLOAD messages during file loading. When SYSLOAD is completed, the Nortel Networks logo appears.)
5. When the Nortel Networks logo appears, press <CR> to continue.
6. Log into the system.
7. Enter the time and date, when prompted.
8. Initiate the installation by selecting the following prompt from the menu:
   <cr> <u> to Install menu
9. Remove the Install Utility diskette and insert the Keycode diskette, when prompted.
   <a> continue with keycode validation
   <y> to confirm that keycode matches CD-ROM release
10. Remove the Keycode diskette and re-insert the Install Utility diskette into the IODU/C floppy drive in Core/Net 0.
11. When the Install Menu appears, select the following options in sequence to copy the software from Core/Net 1 to Core/Net 0, install CP-software, ROMs, and transfer the database to the redundant disk:
    <o> to copy system software from the other Core/Net
    <a> to continue
    <a> to continue
    When the software has copied successfully, you must install CP-software from the hard disk to Flash EEPROM, and install CP-BOOT ROM.
    <CR> press <CR> when you are ready to continue
    <y> to start installation
<a> to continue with ROM upgrade
<y> to start installing CP-BOOT ROM
<a> to continue with ROM upgrade.

When the installation is complete, the Installation Status Summary screen appears.

<CR> to return to the Install Menu

When the Install Menu appears, install IOP-ROM:
<f> to install IOP-ROM only

When the Installation Status Summary screen appears:
<y> to start installation
<y> to continue installing IOP-ROM
<a> to continue with ROM upgrade

When the installation is complete, the Installation Status Summary screen appears.

<CR> to return to the Install Menu

When the Install Menu appears, install the database:
<d> to install database only

When the Installation Status Summary screen appears:
<y> to start installation
<a> to continue transferring the database from the redundant disk

When the Installation Status Summary screen appears:

<CR> to return to the Install Menu

When the Install Menu appears, remove any diskettes in the floppy before rebooting the system:
<q> to quit
<y> to confirm quit
<a> to reboot the system

Wait for “DONE” and then “INI” messages to be displayed before continuing.
Exiting split mode

1. Enable the NT6D65 CNI cards by setting the ENB/DIS faceplate switch to ENB in Core/Net 0.

2. Perform the following in uninterrupted sequence:
   • Press and release the MAN RST button in Core/Net 0.
   • Set the MAINT/NORM switch to NORM in Core/Net 0.

   An HWI534 message indicates the start of memory synchronization. In 10 minutes, an HWI533 message on Core 1 CSPI or SDI terminal indicates the memory synchronization is complete.

3. In Core/Net 1, set the MAINT/NORM switch on the CP card to NORM.

Test Core 1 and Core 0

1. Perform a redundancy sanity test using the following sequence:

   LD 135
   STAT CNI Get status of CNI cards
   STAT CPU Get status of CPU and memory
   TEST CNI core slot Test each inactive CNI card

2. Switch Cores and test the other side (Core 0)

   SCPUSwitch cores
   TEST CPU Test the standby (inactive core)
   TEST CNI core slot Test each inactive CNI card

Note: Testing the CP and CNI cards and synchronizing memory can take up to 20 minutes for each test. When the CP test is complete, the CP memory is automatically synchronized.
3 Clear the display and minor alarms on both Cores.
   CDSP Clear the displays on the Cores
   CMAJ Clear major alarms
   CMIN ALL Clear minor alarms

4 Get the status of the Cores, CNIs, and memory.
   STAT CPU Get the status of both Cores
   STAT CNI Get the status of all configured CNIs and memory

   Note: You may need to execute the STAT CNI command twice before receiving a response from the system.
   **** exit program

Synchronize the hard disks

1 Load LD 137 and synchronize the hard disks. Synchronization may take up to 50 minutes. To be sure that the contents of IODU/C 1 are copied to IODU/C, verify that IODU/C 0 is disabled.
   LD 137
   STAT Get the status of the IODU/C and redundancy
   SYNC Enter “Yes” to synchronize disks. Wait until the memory synchronization successfully completes before continuing.

2 Get the status of the CMDU’s and be sure CMDU 0 is active. Switch if necessary.
   STAT Get the status of IODU/C and redundancy
   SWAP Switch CMDU if necessary
   STAT CMDU Get the status of the IODU/Cs. Be sure the same IODU/C and CPU are active.
   **** exit program
Perform a data dump

Load the Equipment Data Dump Program (LD 43). At the prompt, enter

**LD 43** to load the program

3 When “EDD000” appears on the terminal, enter
**EDD** to begin the data dump

4 When “DATABASE BACKUP COMPLETE” or “DATADUMP COMPLETE” appears on the terminal, enter
**** to exit the program

---

**CAUTION**
If the data dump is not successful, do not continue; contact your technical support organization. A data dump problem must be corrected before proceeding.

Backing out of the parallel reload on the Option 61C/81/81C

1 Place the original **Install disk** 1 into the IODU/C in Core 1.

2 In Core 1, press the MAN RST button.

3 Select <u> to initiate the Install Tool.

4 Remove the Install Program diskette and insert the source keycode diskette.

5 Select <a> to continue with keycode validation.

6 When the install screen appears, select the following options in sequence, and insert the **source** database diskette when you are prompted to do so.
   
   **<h>** to install software, database, CP-BOOT ROM, and IOP-ROM
   
   **<a>** to start installation
   
   **<a>** continue with upgrade
7 When the database installation screen appears, select the following:
   <c> to transfer the previous system database (DBMT)
   (choose this option if the database was converted on-site)
   or
   <a> to install customer database (choose this option if the database was sent to Nortel Networks for conversion)
   <a> to continue with the database install
   <y> to delete the hardware infrastructure database files from the hard disk

8 When the ROM installation screen appears, select the following:
   <a> to continue with the ROM upgrade

9 Following the database installation, upgrade the ROMs:
   <a> to continue with ROM upgrade (CP-BOOT)
   <y> to start installation
   <a> to continue with ROM upgrade (IOP-ROM)

10 Remove the disk from the IODU/C in Core/Net 1.

11 From the main menu, select the following options to quit and reload the system:
   <q> to quit
   <y> to confirm quit

12 Remove any diskettes from the floppy drive, and type
   <a> to reboot the system
In Core 1, perform the following steps:

- enable the NT6D65 CNI cards by setting the ENB/DIS faceplate switches to ENB
- press and release the MAN RST button on the CP card

When SYS700 messages appear on the CP 1 LCD display:
- set CP 1 MAINT/NORM switch to NORM.

Within 60 seconds, the LCD will display the following messages, confirming the process.

**RUNNING ROM OS**
**ENTERING CP VOTE**

An “HWI534” message from the CPSI or SDI port indicates the start of memory synchronization. Within 10 minutes, an “HWI533” message on Core 0 CPSI or SDI TTY indicates the memory synchronization is complete. Wait until the memory synchronization is complete before continuing.

In Core 0, set the MAINT/NORM switch on the CP card to NORM.

Perform a redundancy sanity test.

**LD 135**
**TEST CPU** Test the standby (inactive) Core.
**SCPU** Switch the Cores.
**CDSP** Clear display.
**TEST CPU** Test the standby (inactive) Core.
**SCPU** Switch the Cores.

*Note:* Testing the CPs can take up to 20 minutes for each test. When the test is complete, the memories are automatically synchronized.

Load LD 137 and synchronize hard disks. Synchronization may take up to 50 minutes. To be sure the contents of CMDU 0 are copied to CMDU 1, use the STAT command to verify that CMDU 1 is disabled.

**LD 137**
**STAT CMDU** Get the status of both CMDUs.
**SYNC** Synchronize disks.
You are now out of the parallel reload process, and have returned to the Source software.

Option 51C software conversion

Use this procedure to convert from one X11 software release to another on Option 51C systems only.

Table 7 summarizes the required steps to perform this procedure.

Table 7
Option 51C parallel reload tasks

<table>
<thead>
<tr>
<th>Task</th>
<th>For more information...</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Verify memory</td>
<td>page 45</td>
</tr>
<tr>
<td>2. Perform a data dump</td>
<td>page 45</td>
</tr>
<tr>
<td>3. STAT the hardware</td>
<td>page 45</td>
</tr>
<tr>
<td>4. Install software</td>
<td>page 47</td>
</tr>
<tr>
<td>5. Check for peripheral software download</td>
<td>page 49</td>
</tr>
<tr>
<td>6. Test the system</td>
<td>page 50</td>
</tr>
<tr>
<td>7. Perform a data dump</td>
<td>page 55</td>
</tr>
</tbody>
</table>

Verify memory

Determine whether your system requires additional memory to install new software. Refer to the General Release Bulletin or Software Conversion Procedures (553-2001-320) for memory requirements.

Perform a data dump

1. Load the Equipment Data Dump Program (LD 43). At the prompt, enter LD 43 to load the program
2. When “EDD000” appears on the terminal, enter EDD to begin the data dump
3. When “DATABASE BACKUP COMPLETE” or “DATADUMP COMPLETE” appears on the terminal, enter
   ** to exit the program

   ** CAUTION **
   If the data dump is not successful, do not continue; contact your technical support organization. A data dump problem must be corrected before proceeding.

   ** STAT the hardware **
   1. Load LD 137 and get status of the hard disk.
      LD 137
      STAT Get the status of the hard disks
   2. Load LD 135 and get status of the CP, CNI and memory.
      LD 135
      STAT CPU Get the status of the CP and memory
      STAT CNI Get the status of the CNI

   ** Install software **
   1. Select the CP Install diskette which matches the Call Processor (CP) type on your system.
   2. Insert the CP Install diskette into the floppy drive of the IODU/C.
   3. Press MAN RST on the CP card.
      The system will be booted from the floppy and the Install tool will be automatically invoked. The following screen appears
   4. Press <CR> to continue.
   5. Log into the system and enter the time and date, when prompted.
6 Initiate the database installation by selecting the following command from the menu:
   <u> to Install menu

7 Remove the CP Install Program diskette and insert the Keycode diskette, when prompted.
   <a> to continue with keycode validation
   <y> to confirm that the keycode matches the CD-ROM release

8 When the Install Menu is displayed, select the following options in sequence when you are prompted to do so
   <a> to install software, CP-ROM, and IOP-ROM
   <a> to verify that the CD-ROM is now in drive
   The Installation Status Summary screen appears that lists the options to be installed.
   <y> Yes, start the installation
   <a> continue with upgrade
   When the ROM installation screen appears, select the following prompts in sequence:
   <a> to install CP-ROM from hard disk
   <a> to continue with ROM upgrade
   When all files are copied from the CD-ROM to hard disk, press <CR> to continue.
   <a> to install the IOP-ROM from hard disk
   <y> Yes, start installation
   <a> to continue with ROM upgrade
   The Installation Status Summary screen appears. Verify that CD to disk, disk to ROM, CP-BOOTROM, and IOP-ROM were installed.
   <cr> press return to return to the Install Menu.
   <q> to quit (remove any diskettes from the floppy drive)
   <y> Yes, to confirm quit
<a> to reboot the system

The system will automatically perform a sysload during which several messages will appear on the system terminal. Wait for “DONE” and then “INI” messages to be displayed before continuing.

Check for Peripheral Software Download

Load LD 22 and print Target peripheral software version. The Source peripheral software version was printed during the pre-conversion procedure. If there is a difference between the Source and Target peripheral software version, a forced download will occur during initialization when coming out of parallel reload. System initialization will take longer and established calls on IPE will be dropped.

<table>
<thead>
<tr>
<th>LD 22</th>
<th>REQ</th>
<th>PRT</th>
</tr>
</thead>
<tbody>
<tr>
<td>TYPE</td>
<td>PSWV</td>
<td></td>
</tr>
</tbody>
</table>

Test call processing

Test Call Processing. This includes, but is not limited to the following:

- Check for dial tone.
- Make internal, external, and network calls.
- Check attendant console activity.
- Check DID trunks.
- Check any auxiliary processors.

Complete the upgrade

1. Perform a redundancy sanity test using the following sequence:

<table>
<thead>
<tr>
<th>LD 135</th>
</tr>
</thead>
<tbody>
<tr>
<td>STAT CNI</td>
</tr>
<tr>
<td>STAT CPU</td>
</tr>
</tbody>
</table>
2 Clear the display and minor alarms.
   
   CDSP      Clear the displays on the Cores
   CMAJ      Clear major alarms
   CMIN ALL  Clear minor alarms
   
   ***      exit program

The software conversion is complete.
Adding features and ISM limits

Adding new features and/or modifying Incremental Software Management (ISM) limits require the installation of a new keycode. New CD-ROM software or a reload of existing CD-ROM software is not required, provided there is no change in the X11 software release and issue.

Keycodes are delivered via diskette or electronic file transfer and installed using the key management commands in LD 143.

This section describes how to install a keycode using the commands listed below:

<table>
<thead>
<tr>
<th>Keycode Delivery</th>
<th>Keycode Installation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Diskette</td>
<td>Use the KNEW F0 or KNEW F1 command.</td>
</tr>
<tr>
<td>Electronic file on a PC</td>
<td>Use the KUPL command in LD 143, followed by the KNEW HD command.</td>
</tr>
<tr>
<td>Paper based</td>
<td>Use the KMAN command in LD 143, followed by the KNEW HD command.</td>
</tr>
</tbody>
</table>

Feature expansion and ISM modification is also supported using the Meridian 1 Software Installation Tool. Refer to the “IODU/C Software Installation Tool” section in this document for more information.
Installing a keycode from diskette

**Note:** If the keycode currently resides on the PC hard drive, copy the keycode to a standard 2 MB formatted diskette before beginning this procedure.

1. Insert the keycode diskette into the floppy drive on the IODU/C card in Core 1.
2. In LD 143, print the pending keycode contents.
   - **LD 143** to load the program
   - **KSHO F1 (or F0)** print the contents of the candidate keycode in the floppy drive on Core 1 or Core 0
3. Perform the KDIF command.
   - **KDIF F1 (or F0) REC** to print the differences between the candidate and the current keycodes
   - ******** to exit LD 143

**CAUTION**
The keycode is enabled at the next sysload after the KNEW command is executed in LD 143. To provide appropriate site support, it is highly recommended that the system be in split mode (redundant systems only) and execution of KNEW be conducted onsite immediately prior to sysload and not conducted remotely.

Place the system in split mode

If you have a redundant system, you must put the system in split mode before activating the new keycode:

**Note:** For single CPU systems only: access LD 143 and enter KNEW F0. If there are validation errors, repeat the KNEW F0 command. If validation is not successful, contact your technical support organization. The keycode with new capabilities will be activated at the next restart (sysload). To minimize service impact, manually restart the system at an appropriate time to enable new capabilities.
1. Be sure CP 0 is active and CP1 is standby. You may need to switch CPs:
   - LD 135
   - STAT CPU
   - SCPU to switch CPUs if necessary
   - **** exit program

2. Verify that IODU/C 0 is active. You may need to switch IODU/Cs.
   - LD 137
   - STAT Get the status of IODU/C
   - SWAP Switch IODU/Cs if necessary
   - **** exit program

3. Connect a terminal to the CPSI port in Core 1 to J25 of the I/O panel at the back of the Core. Be sure it is configured as follows. The recommended baud rate is 9600, to be the same as the CPSI port:
   - 8 data bits, no parity, one stop bit, Full duplex, XON protocol

4. In Core 0, set the CP card MAINT/NORM switch to MAINT.

5. In Core 1, disable the NT6D65 Core to Network Interface (CNI) cards by setting the ENB/DIS faceplate switches to DIS.

6. In Core 1, set the MAINT/NORM switch on the CP card to MAINT.

**Install the new keycode in Core 1**

1. Log into the system and enter the date and time.

2. Load overlay 143:
   - LD 143 to load the Keycode Management overlay
   - KNEW F1 to validate the new keycode on the hard drive in Core 1

Ensure that the new keycode does not lower ISM limits or reduce features compared with the existing keycode.

The uploaded keycode is validated against the Security Device, software version, release and issue. It will reside on the your hard disk, and be backed up on a floppy disk upon the next archive command.
Note: If you are changing CP type, software version, release, or issue, use the Software Install Tool rather than KNEW.

3 If there are validation errors, refer to the Fault Isolation section.

4 If successful, exit the overlay and go the next step.
   - Exit.
   **** to exit the program

5 Press the MAN RST button in Core 1.

When the system completes the cold restart, the new keycode will be activated.

Switch call processing

Perform the next four steps in succession to switch call processing from Core 0 to Core 1.

CAUTION

Call Processing will be interrupted! Perform these next steps carefully and quickly. This is the point at which your service is interrupted. Calls in process will be interrupted, especially if Peripheral Software Download takes place. Some calls may be dropped.

1 In Core 0, software disable the IODU/C card.
   DIS CMDU 0 to disable the IODU/C in Core 0

2 In Core 0, set the DIS/ENB faceplate switch on the IODU/C card to DIS.

3 In Core 0, disable the NT6D65 CNI cards by setting the ENB/DIS faceplate switches to DIS. Call Processing will be interrupted.

4 In Core 1, enable the NT6D65 CNI cards by setting the ENB/DIS faceplate to ENB.

5 In Core 1, press the MAN INT button. Call processing will be switched from Core 0 to Core 1 when the warm restart is completed.
Return the system to redundant mode

1. Enable the NT6D65 CNI cards by setting the ENB/DIS faceplate switch to ENB in Core/Net 0.
2. Press and release the MAN RST button in Core/Net 0.
3. Set the MAINT/NORM switch to NORM in Core/Net 0. Memory shadowing is automatically restored after a short delay. Wait until memory shadowing is complete before continuing.
4. In Core/Net 1, set the MAINT/NORM switch on the CP card to NORM.

Synchronize the hard disks

1. When the Nortel Networks logo appears, log into the system and enter the date and time.
2. Load LD 137 and synchronize the hard disks. Synchronization may take up to 50 minutes. To be sure that the contents of IODU/C 1 hard disk are copied to IODU/C 0 hard disk, verify that IODU/C 0 is disabled.
   **LD 137**
   
   STAT Get the status of the IODU/C and redundancy
   SYN Get "Yes" to synchronize disks. Wait until the memory synchronization successfully completes before continuing.

3. Get the status of the IODU/Cs and be sure IODU/C 0 is active. Switch if necessary.
   **STAT** Get the status of IODU/C and redundancy
   SWAP Switch IODU/C if necessary
   **STAT CMDU** Get the status of the IODU/Cs. Be sure the same IODU/C and CPU are active.
   **** exit program

4. Perform a data dump in LD 143.

The keycode installation by the diskette method is complete.
Transferring the keycode file electronically

*Note:* To perform this procedure, a PC running Windows 95® is required.

When the requested keycode is downloaded from the Keycode Delivery System to your PC, use the following procedure to install the new keycode in the Meridian 1.

1. On a PC, access the Meridian 1 system (via a modem) with HyperTerminal® (this application is provided with Windows 95):
   - Click the **Start button | Programs | Accessories | HyperTerminal.**
2. Double-click the HyperTerminal client to the Meridian 1 system.
3. Log into the Meridian 1 system.
4. Load the Keycode Management Program (LD 143).
   - **LD 143** to load program
   - **KUPL** to upload keycodes to the target system
5. Click the **Transfer** menu in HyperTerminal and select **Send Text File.**
6. From the **Files of type** pull-down menu, select **All Files (*.*)**.
7. Locate and select the keycode file on the PC. Use the **Look in** pull-down menu to select the drive on which the keycode is located.
8. Click **Open.**

The keycode will be displayed after the KUPL prompt.

Example:

```
KUPL 0001PBX 0101
9FPAMSRHNN17KRUQAFFSPREQEQVMTHIDHRKDHRKEJR56
```

10. Enter the following command:
   - **KDF REC HD** to compare the existing keycode with the new keycode
Ensure that the new keycode does not lower ISM limits or reduce features compared with the existing keycode.

CAUTION
The keycode is enabled at the next sysload when the KNEW command is executed in LD 143. To provide appropriate site support, it is highly recommended that the system be in split mode (redundant systems only) and execution of KNEW be conducted onsite prior to sysload and not conducted remotely.

Note: For single CPU systems only: access LD 143 and enter KNEW HD. If there are validation errors, repeat the KNEW HD command. If validation is not successful, contact your technical support organization. The keycode with new capabilities will be activated at the next restart (sysload). To minimize service impact, manually restart the system at an appropriate time to enable new capabilities.

Place the system in split mode
If you have a redundant system, you must put the system in split mode before activating the new keycode:

1. Be sure CP 0 is active and CP1 is standby. You may need to switch CPs again:
   
   STAT CPU
   **** exit program

2. Verify that IODU/C 0 is active. You may need to switch IODU/Cs.

   LD 137
   STAT Get the status of IODU/C
   SWAP Switch IODU/Cs if necessary
   **** exit program

3. Connect a terminal to the CPSI port in Core 1 to J25 of the I/O panel at the back of the Core. Be sure it is configured as follows. The recommended baud rate is 9600, to be the same as the CPSI port:
   7 data bits, 1 stop bit, Space parity, Full duplex, XON protocol
4 In Core 0, set the CP card MAINT/NORM switch to MAINT.

5 In Core 1, disable the NT6D65 Core to Network Interface (CNI) cards by setting the ENB/DIS faceplate switches to DIS.

### Install the new keycode in Core 1

1 Log into the system and enter the date and time.

2 Load LD 143 to install the keycode.

   **KNEW HD** to validate the new keycode.

   The uploaded keycode is validated against the security device. It will reside on your hard disk and on a backed up floppy disk.

3 If there are validation errors, repeat steps. If validation is not successful, contact your technical support organization.

4 If successful, exit the overlay and go the next step.

   • Exit.

   **** to exit the program

### Switch call processing

Perform the next four steps in succession to switch call processing from Core 0 to Core 1.

**CAUTION**

Call Processing will be interrupted! Perform these next steps carefully. This is the point at which your service is interrupted. Calls in process will be interrupted, especially if Peripheral Software Download takes place. Some calls may be dropped.

1 In Core 0, set the DIS/ENB faceplate switch on the IODU/C card to DIS.

2 In Core 1, enable the NT6D65 CNI cards by setting the ENB/DIS faceplate to ENB.
3 In Core 0, disable the NT6D65 CNI cards by setting the ENB/DIS faceplate switches to DIS.

4 In Core 1, press the MAN INT button. Call processing is now switched from Core 0 to Core 1.

**Return the system to redundant mode**

1 Enable the NT6D65 CNI cards by setting the ENB/DIS faceplate switch to ENB in Core/Net 0.

2 Press and release the MAN RST button in Core/Net 0.

3 Set the MAINT/NORM switch to NORM in Core/Net 0.

4 In Core/Net 1, set the MAINT/NORM switch on the CP card to NORM.

**Synchronize the hard disks**

1 When the Nortel Networks logo appears, log into the system and enter the date and time.

2 Load LD 137 and synchronize the hard disks. Synchronization may take up to 50 minutes. To be sure that the contents of IODU/C 1 are copied to IODU/C, verify that IODU/C 0 is disabled.

LD 137

<table>
<thead>
<tr>
<th>STAT</th>
<th>Get the status of the IODU/C and redundancy</th>
</tr>
</thead>
<tbody>
<tr>
<td>SYNC</td>
<td>Enter &quot;Yes&quot; to synchronize disks. Wait until the memory synchronization successfully completes before continuing.</td>
</tr>
</tbody>
</table>

3 Get the status of the CMDUs and be sure CMDU 0 is active. Switch if necessary.

<table>
<thead>
<tr>
<th>STAT</th>
<th>Get the status of IODU/C and redundancy</th>
</tr>
</thead>
<tbody>
<tr>
<td>SWAP</td>
<td>Switch CMDU if necessary</td>
</tr>
<tr>
<td>STAT CMDU</td>
<td>Get the status of the IODU/Cs. Be sure the same IODU/C and CPU are active.</td>
</tr>
<tr>
<td>****</td>
<td>exit program</td>
</tr>
</tbody>
</table>

4 Perform a data dump in LD 143.

The keycode installation by the electronic transfer method is complete.
Entering the keycode manually

Before beginning this procedure, you must have a copy of the keycode. The keycode can reside on paper or as an electronic file. To enter the keycode manually, you will type the keycode in LD 143 as 21 lines, 16 characters per line.

1. Log into the system.
2. Load the Keycode Management Program (LD 143).
   - LD 143 to load program
   - KMAN manually enter the keycode to the target system
3. Type keycode file, 21 lines of 16 characters each. Press return to go to the next line.
   - Note: When entering the keycode, do not enter the header information that proceeds the keycode.
4. Type “end” at line 22 to end the process.
5. Press enter. The new keycode file will be saved on the hard disk.
6. For single CPU systems, skip to step 7. For redundant systems only: Before activating the keycode, you must put the system in split mode with call processing on Core 0.
7. If there are no validation errors, use the command:
   - KNEW HD to validate the new keycode.
   - The uploaded keycode is validated against the security device.
8. If there are validation errors, repeat the KNEW HD command. If validation is not successful, contact your technical support organization. If successful, continue to the next step.
9. For redundant systems only:
Perform the next four steps in succession to switch call processing from Core 0 to Core 1.

**CAUTION**

*Call Processing will be interrupted!* Perform these next steps carefully. This is the point at which your service is interrupted. Calls in process will be interrupted, especially if Peripheral Software Download takes place. Some calls may be dropped.

10 In Core 0, set the DIS/ENB faceplate switch on the IODU/C card to DIS.

11 In Core 1, enable the NT6D65 CNI cards by setting the ENB/DIS faceplate to ENB.

12 In Core 0, disable the NT6D65 CNI cards by setting the ENB/DIS faceplate switches to DIS.

13 In Core 1, press the MAN INT button. Call processing is now switched from Core 0 to Core 1.

14 Enable the NT6D65 CNI cards by setting the ENB/DIS faceplate switch to ENB in Core/Net 0.

15 Press and release the MAN RST button in Core/Net 0.

16 Set the MAINT/NORM switch to NORM in Core/Net 0.

17 In Core/Net 1, set the MAINT/NORM switch on the CP card to NORM.

18 When the Nortel Networks logo appears, log into the system and enter the date and time.

19 Load LD 137 and synchronize the hard disks. Synchronization may take up to 50 minutes. To be sure that the contents of IODU/C 1 are copied to IODU/C, verify that IODU/C 0 is disabled.

**LD 137**

| STAT | Get the status of the IODU/C and redundancy |
| SYNC | Enter “Yes” to synchronize disks. Wait until the memory synchronization successfully completes before continuing. |
20  Get the status of the CMDUs and be sure CMDU 0 is active. Switch if necessary.

```
STAT    Get the status of IODU/C and redundancy
SWAP    Switch CMDU if necessary
STAT CMDU Get the status of the IODU/Cs. Be sure the same IODU/C and CPU are active.
****    exit program
```

21  Perform a data dump in LD 43.

**Note:** For single CPU systems, the keycode with new capabilities will be activated at the next restart (sysload). To minimize service impact, manually restart the system at an appropriate time to enable new capabilities.

The keycode in installation by the manual entry method is complete.
Keycode management, LD 143

**IMPORTANT**
Access to LD 143 is controlled by the LAPW and KCCD (Limited Access Password) configuration settings in LD 17. The default setting restricts access to LD 143. Access to LD 143 should be limited to the system administrator or support personnel (refer to *X11 Administration* (553-3001-311) for more information).

The Keycode Management commands in LD 143 that are used with systems equipped with IODU/C cards include:

- KUPL
- KMAN
- KRVR
- KOUT
- KSTT
- KSHO
- KDIFF
- HELP
- ABKO
- ARES
Note: To use the KUPL command, a PC running Windows 95® and a keycode file are required.

The KUPL command allows you to upload keycodes to the Meridian 1 system. KUPL supports direct upload from a keycode diskette, as well as remote file transfer from a Windows 95 PC.

KUPL is used to add features or modify ISM limits only. Refer to “Adding features and ISM limits” on page 63 for keycode upload procedures.

KMAN

The KMAN command is used to manually enter a keycode.

Before beginning this procedure, you must have a copy of the keycode. The keycode can reside on paper or as an electronic file. To enter the keycode, you will type the keycode in LD 143 as 21 lines, 16 characters per line.

1 Log into the system.

2 Load the Keycode Management Program (LD 143).

   LD 143 to load program
   KMAN manually enter the keycode to the target system

3 Type the keycode file, 21 lines of 16 characters each. Press return to go to the next line.

   Note: Enter the keycode only. Do not enter the header information.

4 Type “end” at line 22 to end the process.

5 Press enter. The new keycode file will be saved on the hard disk.

6 For single CPU systems, skip to step 7. For redundant systems only: Before activating the keycode, you must put the system in split mode with call processing on Core 0.

7 If there are no validation errors, use the command:

   KNEW to install the new keycode.

   The uploaded keycode is validated against the security device.
8 If there are validation errors, repeat the KNEW command. If validation is not successful, contact your technical support organization. If successful, continue to the next step.

9 For redundant systems only:
   • switch call processing from Core 1 to Core 0
   • install the keycode using the KNEW command in LD 143
   • return the system to redundant mode
   • synchronize the hard disks

10 Perform a data dump in LD 43.

   Note: For single CPU systems, the keycode with new capabilities will be activated at the next restart (sysload). To minimize service impact, manually restart the system at an appropriate time to enable new capabilities.

**KRVR**

The KRVR command is used to revert from the current keycode to the most recent system keycode.

1 Log into the system.

2 Load the Keycode Management Program (LD 143).

   LD 143 to load program
   KRVR revert the old keycode as the current system keycode

   If no validation error occurs the old keycode was accepted. The screen will display the conditions that must be fulfilled for the keycode to become permanent.

3 If there are validation errors, repeat steps 2. If validation is not successful, contact your technical support organization. If successful, continue to the next step.
Exit.

The new keycode with new capabilities will be activated at the next restart (sysload). To minimize service impact, manually restart the system at an appropriate time to enable new capabilities.

**KOUT**

The KOUT command is used to delete a new keycode before it is activated (by means of a sysload).

1. Load overlay 143.
   - LD 143 to load program
   - KOUT delete the new keycode while in trial
   - OK CCBR010 New Keycode deleted. The current keycode id retained

2. Exit.
   - **** to exit the program

**KSTT**

The KSTT command is used to print the status of all keycodes present in the system.

1. Load overlay 143.
   - LD 143 to load program
   - KSTT to display the old and current keycodes
   - REC display current keycode
   - OK
   - HD display candidate keycode on Hard Disk:
   - OK

2. Exit.
   - **** to exit the program
KSHO

The KSHO command is used to print the content of a specified keycode.

1 Load overlay 143.

   LD 143          to load program
   KSHO < param>   show content of current keycodes

   where <param> may have one of the following values:

   NEW              accepted new keycode
   REC              currently used keycode
   OLD              previously used keycode
   F0               candidate keycode on diskette in /f0 floppy drive
   F1               candidate keycode on diskette in /f1 floppy drive
   HD               candidate keycode which was uploaded to hard disk

   The KSHO command with no parameter displays a help text to guide in selecting the appropriate parameter.

2 Exit.

   ****          to exit the program
The KDIF command is used to show the differences between two specified keycodes.

1. Load overlay 143.
   - `LD 143` to load program
   - `KDIF <k1> <k2>` Show differences between the selected keycodes

   where `<param1>` and `<param2>` may have one of the following values:
   - `NEW` accepted new keycode
   - `REC` currently used keycode
   - `OLD` previously used keycode
   - `F0` candidate keycode on diskette in /f0 floppy drive
   - `F1` candidate keycode on diskette in /f1 floppy drive
   - `HD` candidate keycode which was uploaded to hard disk

The KDIF command with no parameter displays a help text to guide in selecting the appropriate parameters.

2. Exit.
   - `****` to exit the program
HELP

The HELP command displays the available keycode management commands.

1. Load overlay 143.
   - **LD 143** to load program
   - **HELP** print Keycode Management commands

Keycode Management Commands
- **KSTT** List all keycodes
- **KSHO** `<param>` display content of `<param>`
- **KDIF** `<P1>` `<P2>` compare 2 keycodes
- **KNEW** `<param>` Select new candidate keycode from: F0,F1,HD
- **KRVR** Select the OLD keycode as the new candidate.
- **KOUT** Remove pending candidate
- **KMAN** Line by line candidate keycode file creation
- **KUPL** Candidate keycode file upload

Parameters:
- **NEW** accepted new keycode
- **REC** currently used keycode
- **OLD** previously used keycode
- **F0** candidate keycode on diskette in /f0 floppy drive
- **F1** candidate keycode on diskette in /f1 floppy drive
- **HD** candidate keycode which was uploaded to hard disk

2. Exit.
   - **** to exit the program
Two types of backup methods (unattended and attended) are provided to save and restore all IODU/C customer specific files on floppy diskette:

- Attended Backup (ABKO) LD 143
- Unattended Backup (BKO) LD 43 (see page 84)

ABKO is an interactive procedure in LD 143 requiring the presence of someone onsite. LD143 ABKO/ARES commands are used to initiate the backup. The estimated number of diskettes required to complete the backup is displayed. There are no limitations on the number of diskettes needed. When larger databases require more than one diskette to complete the backup, the floppy diskettes should be labeled as floppy #1, floppy #2, and etc. This section describes how to use the commands in LD 143 to backup the customer database to 2 MB floppy diskettes.

The ABKO command requires the presence of a craftsperson for interactive storing to and restoring from a removable media.

1. Load overlay 143.
   
   **LD 143** to load program
   
   **ABKO** request attended backup

   The system displays the list of files that will be archived and the estimated number of diskettes needed for backup.

   The screen menu will request the craftsperson to insert the 1st diskette in the floppy drive on side 0.

2. Insert the 1st diskette.

3. Press <a>, diskette is now in the floppy drive in side 0.
   
   Dots “.” are used to indicate the progress of backup.

4. If needed the menu will request to insert the next floppy; insert “2nd”, “3rd”, “4th”,...etc.
5 After each floppy insertion;
   Press <a>, diskette is now in the floppy drive in side 0
   After all files have been processed, the menu will request the
   craftsman to reinsert floppy disk #1. This will store a signature file
   “Archive.dat” in floppy #1.

6 Press <a>, diskette is now in the floppy drive in side 0.
   The menu will indicate that it is verifying the “Archive.dat” file and that
   backup has been successful. Also, the menu will indicate the number of
   diskettes used.
   Backup process ended successfully.

7 In the menu, enter <q> quit.

8 Exit.
   **** to exit the program

This concludes the ABKO, attended backup procedure.

ARES

The ARES command is used to restore the most recent customer database.
The ARES command requires the presence of a craftsman for interactive
storing to and restoring from a removable media.

1 Load overlay 143.
   LD 143 to load program
   ARES request attended restore
   The system menu will request the craftsman to insert the 1st diskette
   in the floppy drive on side 0.

2 Insert the 1st diskette in the floppy drive on side 0.

3 Press <a>, diskette is now in the floppy drive in side 0.
   System verifies that diskette #1 is present in the floppy drive and also
   verifies that the diskette belongs to a complete backup. Once the above
   is confirmed the system presents the date when the backup has been
   performed.
4 Press <y> to restore the database.
   The progress status is displayed during the restore process. Files are
   copied in a temporary location.

5 If needed the menu will request to insert the next floppy; insert “2nd”,
   “3rd”, “4th”....etc.

6 After each floppy insertion;
   Press <a>, diskette is now in the floppy drive in side 0.
   The menu will indicate the restore status and the integrity of the files.
   When the files are confirmed and the restore is complete, the files are
   moved to their permanent location.
   Restoring process is complete.

7 In the menu, enter <q> quit.

8 Exit.
   **** to exit the program

This concludes the ARES, attended restore procedure.

BKO (LD 43)

Unattended backup is an enhancement of the LD 43 BKO/RES commands.
Unattended backup does not require an installer to be onsite. It allows the
reuse of both floppy diskettes on a redundant system during scheduled
midnight routine or during remote operation. Files, can be compressed in
order to fit archived data on existing media. Compression will be performed
when the database size exceeds the capacity of 1 floppy used in the system
(1.44 MB in IODU/C). On redundant systems (Opt61C/81/81C) both floppy
drives are used thus providing cumulative 2.88MB capacity on IODU/C
based systems. Note that compression will be applied in order to fit the
database on 1 floppy diskette. The second floppy will be used only if the
compressed data base does not fit on a single floppy.
Prior to unattended database backup, both Cores must have diskettes installed in the IODU/C.

1. Load overlay 43.

   **LD 43** to load program
   **BKO** request unattended backup

   BKO command will use two floppy diskettes and compression if the total archive exceeds 1 floppy diskette size.

   If no validation errors occur, the screen will display that the database backup is complete. A report will be displayed indicating which floppy drive was used by the procedure.

2. If there are validation errors, repeat step 1. If validation is not successful, contact your technical support organization. If successful, continue to the next step.

3. Exit.

   **** to exit the program

**RES (LD 43)**

Prior to unattended database restore, both CORES must have diskettes installed in the IODU/C.

1. Load overlay 43.

   **LD 43** to load program
   **RES** request unattended restore

   The RES command will check the number of diskettes against the number of archived floppy diskettes. Any mismatch in the number of diskette or read/write errors will result in immediate exit.

   If no validation error occurs, the screen will display that the database restore is successful.

2. If there are validation errors, repeat step 1. If validation is not successful, contact your technical support organization. If successful, continue to the next step.

3. Exit.

   **** to exit the program
Using the Distributor Keycode Application

The Distributor Keycode Application (DKA) is a Windows 95 ® based utility program which enables distributors to download keycodes from a remote server (known as Keycode Delivery Server (KDS)). DKA makes use of a standard Wizard Windows 95 interface to guide the user’s operation.

Note: Electronic retrieval of keycodes via DKA is not supported in European markets. If you are downloading keycodes from Europe, please refer to “Using the Keycode Retrieval Utility” on page 107.

This section contains the following procedures:

- “Installing DKA” on page 88
- “Adding the KDS network client in Dial-up Networking” on page 93
- “Downloading from KDS” on page 97
- “Reading from a File” on page 103
- “Manually entering a keycode” on page 104

Note: The “Installing DKA” and “Adding the KDS connection in Dial-Up Networking ®” procedures must be completed before the "Downloading from KDS” procedure can be performed.
Hardware and Software Requirements

To install and use the DKA program, certain requirements must be met:

- You must have a PC or compatible computer with a Pentium or compatible Intel processor running the Windows 95 or Windows 95B operating system.
- A modem that supports 14.4kbps or less must be installed and configured on your PC. To ensure that a modem is configured correctly under Windows 95, you must configure a modem through the Control Panel (using 8 data bits, Parity None, Stop Bits 1). Additionally, the modem must be configured with the correct Dial Prefix (Access Code) used by your telephone system to access an outside line. This modem must access a standard analog telephone line.
- Approximately 5 MB free hard drive space for installation of the DKA program and, if desired, storage of keycodes.
- Microsoft Dial-up Networking software must be installed on the PC (provided with Windows 95)
- The following procedures must be performed before downloading keycodes: “Installing DKA,” and “Adding the KDS connection in Dial-Up Networking ®.”

Installing DKA

Once you have checked that your PC and modem meet the system requirements listed above, you are ready to install the DKA program onto your PC. Once the program is installed, you will make a Shortcut to the program. This Shortcut will appear on your Windows 95 desktop. Double-clicking this Shortcut will give you easy access to the program.

The DKA program is installed as follows:

1. Locate the DKA Installation diskette.
2. Insert the diskette, label facing upwards, into the floppy drive on your PC.
3. Run the Windows Explorer ® application by clicking and dragging the Start button on the lower left corner of the screen. Drag the Start button to Program Files then Windows Explorer.
4 In the **Windows Explorer** application, click the 3.5" Floppy drive (A:) from the left side of the window.

5 In the right side of the window, double-click the **Setup.exe** file (which has a computer icon to the left of it).

   Wait for the **Setup** program to prepare for installation.

   The Identification Screen is displayed.

6 Enter the requested information in the **Name** and **Company** fields.
7  Click **Next** or press return.

The Software License screen is displayed. This screen contains a scrollable text box that contains the legal agreement governing the use of the DKA software.

8  If you accept the terms of the license agreement, click the **Next** button. If you do not accept, click **Cancel** and the program installation will be stopped.

The Destination Directory screen appears. This screen indicates that the DKA program will be installed on the hard drive in a folder called **DKA**.

9  Click **Next** or press return.

The Read Note screen appears. This screen is used to read any Read me files for the DKA program.
10 Read the contents of the Read Me files: Select file, then click **Open**. Click **Next** or press return.
The Install Completed screen appears. This screen indicates that the Distributor Keycode Application has been successfully installed on your PC.

11 Click the Finish button to close the setup program.

Creating a Shortcut

To make the Distributor Keycode Application easier to access, create a Shortcut by doing the following:

1 Select the dka.exe file located in the DKA folder on the (C:) drive.

2 Click on the File menu and drag down to Create Shortcut.

A file called Shortcut to dka.exe appears in the DKA folder.

3 Click and drag the Shortcut to dka.exe file to a convenient location on your desktop and release.

Now the Distributor Keycode Application may be accessed easily by double-clicking on the Shortcut to dka.exe file on the desktop.
Adding the KDS network client in Dial-up Networking

Before you can download keycodes, you must configure the Dial-up Networking KDS client, as described below. Dial-up Networking stores and manages all communication parameters (phone number, dial prefixes, user name, password, etc.) necessary for connecting to the Keycode Download Server.

1. Click the Start button on the lower left corner of the PC desktop and drag to Programs|Accessories|Dial-up Networking.

2. Double-click the Make a New Connection icon in the Dial-Up Networking window and enter the following:
   
   **Type a name for the computer you are dialing:**
   Richardson KCD Server 1 (example)

   **Select a modem:**
   The modem must support 14.4kbps or less with the following configuration: Data Bits 8, Parity None, Stop Bits 1
3 Click **Next** and enter the following for regions where the 888 Area Code is available:

Enter the Area Code as follows: **888**

Telephone Number: **685-3923**

Country code: **United States of America**

*Note:* The information entered in the Make New Connection window must match this information. If you are using DKA in a market other than the United States of America, ensure that the Area Code, Telephone Number, Dial Prefix, and Country code are configured correctly.

*Note:* In regions where the 888 Area Code is not applicable, the number which must be substituted is: **(972) 685-1764**. This number must be configured in Dial-Up Networking.

4 Click **Next**.

You will receive a message that you have successfully created a new Dial-Up Networking connection. Click **Finish** or press return to complete the procedure.
Configure the Type of Dial-Up Server

1. Click the \textbf{Start} button on the lower left corner of the PC desktop and drag to \textit{Programs|Accessories|Dial-up Networking}.

2. Click on \textbf{Richardson KCD Server 1}.

3. Select the \textbf{File menu} and choose \textbf{Properties}.

4. Click \textbf{Server Type...} to continue.

5. Configure the \textbf{Server Type} window with the following information:
   - Type of Dial-Up Server: \textit{PPP Windows 95 Windows NT 3.5 Internet}
   - Advanced ‘s: \textit{Enable software compression}
   - Advanced network protocols: \textit{TCP/IP}
   - TCP/IP Settings....: \textit{use the default settings}

6. Click \textbf{OK} or press return.

7. Click \textbf{OK} again to return to the Dial-Up Networking window.
Downloading from KDS

The following procedure is used to request and receive keycodes from a remote server, known as KDS (Keycode Delivery Server). This procedure assumes that you have already installed the DKA program as described in “Installing DKA” on page 88, and have added and configured the Dial-up Networking client as described in “Adding the KDS network client in Dial-up Networking” on page 93.

Establish the PPP connection to the KDS server via Dial-up Networking

1. Double click on the Richardson KCD Server 1 Dial-Up Networking client. Enter user name “nortel-keycode” and password “97enable.” Click the Connect button and verify that the modem dials a call and the Dial-Up Networking client successfully connects to the Richardson KCD Server 1.

Once the Dial-up Networking PPP connection has been established, continue with the download by starting the DKA application:

2. Double-click on the Shortcut to DKA icon on the PC desktop.

A gray screen appears that includes four menus and a Toolbar with buttons for essential commands.
3. Click on the **Tools** menu and select **Download Keycodes**.

   The KDS Welcome screen appears.

4. Click **Next** or return to download a keycode from KDS.

   The Build a Request List screen is displayed. This screen has four information fields which must be completed for each keycode request that is submitted.
5 Enter the information into the four fields as described in Table 8.

Table 8
“Build a Request List” fields

<table>
<thead>
<tr>
<th>Name of field</th>
<th>How the information is entered in the field</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product Name</td>
<td>Select the product family of the system for which you are requesting a keycode.</td>
</tr>
<tr>
<td>System ID</td>
<td>Enter the System ID for the system for which you are requesting a keycode.</td>
</tr>
<tr>
<td>NTI Number</td>
<td>Click in the field and type in the NTI Number for the system for which you are requesting a keycode (the NTI Number is the same as the NT order number).</td>
</tr>
<tr>
<td>File Name</td>
<td>Enter a file name for the keycode you will be downloading. If the keycode will be downloaded to the hard drive ((C:) drive), use the following file naming convention: c:\DKA&lt;System ID&gt;\NTI Number&gt;. When you click Add, a .kcd file extension is added to the file name. If the keycode will be downloaded to a floppy diskette in the 3.5&quot; Floppy drive (A:), the file name must be named “keycode” so the Meridian 1 can recognize the file. When you click Add, a .kcd file extension is added to the file name.</td>
</tr>
</tbody>
</table>

6 Click **Add** to continue. The request will appear in the Request List scroll box.

When a request is added to the list, another request may be added by filling out the fields with information for another keycode, and again clicking the Add button.

To remove a request from the list, select the request in the Request List scroll box and click the Delete button.

7 Click the **Next** or press return.

The KDS Billing Notice screen is displayed
8 Enter the information in Table 8 into the KDS Billing Notice screen.

Table 9
Fields on the KDS Billing Notice screen

<table>
<thead>
<tr>
<th>Name of field</th>
<th>How the information is entered in the field</th>
</tr>
</thead>
<tbody>
<tr>
<td>Distributor Name</td>
<td>Enter the name of the Distributor who is requesting the keycode(s).</td>
</tr>
<tr>
<td>User Name</td>
<td>Enter the name of the person requesting the keycode(s).</td>
</tr>
<tr>
<td>Telephone Number</td>
<td>Enter the telephone number that can be used to contact the individual who is requesting the keycode(s). For example: (408) 555-1212.</td>
</tr>
</tbody>
</table>

9 Click the Next button or press return.

10 Click Next or press return.

The KDS Download screen is displayed.

**Note:** The Dial-up Networking connection must have been established, as described in “Establish the PPP connection to the KDS server via Dial-up Networking” on page 97.
11 Click **Start** to begin downloading the keycode(s).

*Note:* This starts the keycode download process. A socket connection is established over the existing PPP connection. Next, the provided login information is sent to the Keycode Delivery Server and verified. Then the requested keycodes are downloaded to your PC in the location you specified in the Build a Request List window. Status is displayed in the Download Status box.
12 Click **Next** to receive the “KDS Download Results” screen, summarizing the results of the download.

![KDS Download Results](image)

13 Double-click the network icon in the lower right corner of the screen.

![Network Icon](image)

14 The Dial-up Networking status window appears. Click the **Disconnect** button to end the connection to the network.

The “Download from KDS” procedure is complete. Refer to “Keycode Management, LD 143” in this document for keycode installation instructions.

If there was a problem downloading keycodes, the problem keycodes are listed in the “Unsuccessfully downloaded keycodes” scroll box.

**Note:** If the download was unsuccessful, verify that the correct telephone number and Dial Prefix are configured in Dial-up Networking.

When the requested keycode is downloaded from the Keycode Delivery System to your PC, refer to “Adding features and ISM limits” on page 63 for keycode installation procedures.
Reading from a File

The following procedure is used to learn information about the properties of an existing keycode, or a keycode that was just downloaded from KDS. In this procedure you will specify a keycode file in a location on your hard drive or on a floppy diskette that is inserted in your floppy disk drive.

You will also specify a “Product type” to examine within the keycode file, in case there are multiple keycodes within the keycode file being examined.

This procedure assumes that you have already installed the DKA program as described in “Installing DKA” on page 88.

1. Double-click on the Shortcut to DKA icon on the PC desktop.
2. Select Open from the File menu.

   A navigation dialog box appears. In the navigation dialog box, locate the keycode. For a keycode residing on a floppy drive, this is the 3.5” Floppy drive (A:); for a keycode residing on the hard drive, this is most likely the C: drive.

3. Click OK.
The Keycode file is displayed in a format similar to the hardcopy Keycode Acknowledgment sent to a customer. The Keycode itself is displayed at the bottom of the file, in 21 rows of 16 characters each.

The “Reading from a File” procedure is complete.

Manually entering a keycode

The following procedure is used to manually enter a keycode for the purpose of creating and storing a keycode file.

This procedure assumes that you have already installed the DKA program as described in “Installing DKA” on page 88.

1. Double-click on the Shortcut to DKA icon on the PC desktop.

2. Select Manual Entry from the Tools menu.
The Keycode Entry screen is displayed. This screen consists of rows and four columns (A-D) into which the keycode is entered four characters at a time. When 16 characters (four cells) are entered in a row, the program tries to validate that row. If the row does not validate, a red X appears to the left of that row to indicate invalidity.

The Clear All... button is used to erase all characters in the cells that have been entered on the Keycode Entry screen. A dialog box will prompt “Are you sure you want to clear the Keycode characters?” when this button is selected. Confirming the dialog erases all characters in all cells.
3 When the entire keycode has been entered, click the **Save...** button.

If the keycode is valid, the **Save As** screen is displayed. This screen allows you to specify the file name your keycode will be saved as and the directory where it will be saved.

![Save As Screen](image)

4 From the **Save in** pull-down menu, select the drive location where you want to save the keycode.

5 In the **File Name** field, type the name you want your keycode file to be saved as. Note that the `.kcd` extension will be appended to that filename.

   To save the keycode file nested within folders, double-click on the folder in which the keycode file will ultimately be saved. When you have navigated to the folder where you would like to save the keycode file, click the **Save** button.

6 Click **Save** or press return.

The keycode file has been saved as specified. The “Manually Entering a Keycode” procedure is complete.
Using the Keycode Retrieval Utility

The Keycode Retrieval Utility is a feature of the Nortel Networks Information Center (NIC) web site that allows distributors to download keycodes. A distributor is considered to "own" a keycode once it has been manufactured and its associated order invoiced. This keycode will then become available for browsing and retrieval on the NIC web site.

*Note:* The Keycode Retrieval Utility is available in European markets only. If you are downloading keycodes from outside of Europe, please refer to “Using the Distributor Keycode Application” on page 87.

This sections contains the following procedures:

- “Applying for access” on page 108 and
- “Downloading keycodes” on page 113

If you do not have access to the NIC web site, you must perform the "Applying for access" procedure, and wait 1-2 business days for your account to be activated, before the "Downloading keycodes" procedure can be performed.

The NIC Web site runs SSL for Encryption. This means that if you are accessing the Internet through a corporate firewall, port 443 must be enabled before you can create an account or fully access the site.

If you already have access to the NIC web site, you can go directly to the "Downloading keycodes" procedure.
Applying for access

If you do not already have access to the NIC web site, use the following procedure to apply for access.

1. Start your web browser software.
2. Enter the URL "http://www.nortel.com/nic" in the Address or Net Site bar and press Return or Enter.
3 Scroll down until the following three selections are displayed. Click on the **Apply for Access** logo.

![Image of Nortel Information Center](http://www.nortel.com/nic/)

Please be aware also that this site uses SSL to encrypt the link between your browser and our server. This means that if you are accessing the Internet through a corporate firewall, port 443 must be enabled before you can create an account or access the rest of this site.

---

**Options**

- **SSL Port 443 Test**
  To test to see if you have port 443 access try the link below.

- **Apply for access**
  If you do not have an account you must apply for one.

- **Login to the system**
  Click to Login to the system.

Our voice help line is available 8:00am to 5:00pm Central standard time.

For more information on the Nortel Information Center please call us at 972-634-1335 or send email to support@internallntc.com.

If you don’t have e-mail, send us feedback using forms. Click here.

---

Use this link to send us email questions about this service.
4. The Account Creation Forum screen appears. Select the link of the group that accurately lists your organization's affiliation to Nortel Networks.

Nortel Information Center Account Creation Forum

Welcome to the Nortel Information Center (NIC). This page allows you to create an account and log in to NIC. It is very important that you select the correct affiliation when applying for access to the NIC. Check each of the links below and choose the correct link to complete your account request. If you have any questions regarding which affiliation is correct for you, please call or email us before submitting your account request. Our phone number is (+1) 905-279-0995 and our email address is support@lists.nortel.com.

This group requests North America CPE Distributors, North America DAS Members, CABA DAS Members, BNDA Members, DAS Only Distributors and NAS Only Distributors. Click here to apply for the above group access.

This group requests only European DAS Only Distributors. Click here to apply for European Distributor Access Only.

This group requests only European Member 1 Distributors and EMDone members. Click here to apply for European Distributor and EMDone Access Only.
5 The Request an Account screen is displayed. Fill out the form completely.

![Request An Account Form]

- Use the form to request an account on the server. The information that you enter below will be emailed to the system administrator for approval.
- After approval, your account will be set up on the system.
- Please allow 1-2 business days for this process.
- If you have questions, please call 577-804-1550.
- Also, if you think there is a possibility that you already have an account, please send an email to info@nt5d61ioduc.com before filling out another application.

- **Your E-mail Address:**
- **Subject:** New Web Account Request

Account information:
- **Your E-mail Address:**
- **Your Name:**
- **Company Name:**
- **Address:**
- **City:**
When you have completed the form, click the **Send Message** button at the bottom of the page.

**BEFORE REGISTRATION, PLEASE READ THE FOLLOWING**

In registering your user account on this page, you will be considered to have agreed with the following conditions on the information found on this web page. Northern Telecom, will show due diligence in the prevention of the spread of software causing harm to distributor sites. However, the following conditions apply to the use of this service:

**NOTICE REGARDING SOFTWARE, DOCUMENTS AND SERVICES AVAILABLE ON THIS WEBSITE**

The software and documentation on this web site are provided "as is" and without warranty of any kind or nature, written or oral, express or implied. In no event will Northern Telecom and /or its suppliers be liable to or through a customer for: (1) any indirect, special, incidental and/or consequential damages (including but not limited to, lost profits, lost savings, or interruptions of business) suffered by a customer for any reason, (2) any damages suffered by a customer as a result of improper downloading procedures or hardware set up at the customer site; (3) any claim against a customer by any third party for damages of any kind, any or all of which arise from or in connection with the delivery, use, or performance of software and documentation found on this web page or the provision of or failure to provide services from this server and even if Northern Telecom and /or any of its suppliers have been advised of the possibility of such loss.

After you click the Send Message button, your application will be submitted to the system administrator. Be sure to remember your User ID and password, which should be activated in 1-2 business days.
Downloading keycodes

Use this procedure only after you have completed the "Applying for Access procedure" and your User Name and Password are activated.

1. Start your web browser software.
2. Enter the URL "http://www.nortel.com/nic" in the Address or Net Site bar and press Return or Enter.

![Image of Nortel Information Center](image)

Nortel Information Center

Welcome! You have connected to the Nortel Enterprise Networks, Nortel Information Center.

This is the home for technical information on Nortel Enterprise Network Products. This site only supports the following affiliations:

- North American Distributors
- European Distributors
- European DAC Members
- European Magellan Passport Distributors
- North American DAC Members
- CALA DAC Members
- ISLJNA Members

You must have an affiliation with one of the groups above before access will be granted.
3 Scroll down until the following three selections are displayed. Click on the Login to the System logo.

4 Enter your User name and Password, and click OK.
5 Upon logging in successfully, the following screen is displayed. Click **Distributor Specific Information** under Nortel Supported Forums.
6 Click **Keycode delivery**.
Click Keycode Retrieval Utility.

Nortel Customer Data Access

Welcome to the Nortel Galaxy Customer Data Access facility. This secure customer data delivery utility provides direct access to Nortel keycodes and other information. To access this site, you must have a valid user account; please contact your NORTEL representative to register for access. For more information on using this service, please read Access to Frequently Asked Questions. If you have further queries or problems with this service, send an email to our support address 54611078@nt.com.

Keycode Retrieval Utility

Nortel Home

Copyright, Disclaimer and Other Legal Information
All content Copyright © 1996, Nortel. All Rights Reserved.
Enter your Keycode Retrieval User ID and Password, then click Logon.

*Note:* The Keycode Retrieval User ID and Password may differ from the Login User Name and Password.

---

**Nortel Keycode Retrieval**

**User:** Unknown | **Company:** Unknown | **Language:** ENG

Before retrieving keycode data, you must logon using a valid user ID and password. Please contact your Nortel Customer Service Representative to become a registered user.

**User ID:**

[Logon]

---

**Nortel Home**

Copyright, Disclaimers and Other Legal Information

ฉบับสมบัติโดยสิทธิ์ของกรุงเทพฯ โทรทัศน์ จำกัด
9 Click on the System Types pulldown menu and select the appropriate choice.

10 Enter the Distributor Purchase Order #, Nortel Order #, and System Site ID#.

11 Click the **Retrieve** button.
The results of the query are displayed. To save the keycode as a file, click the **Save To File** button. Select the drive and location where the keycode will be saved, and click **Save**.

The procedure is complete.
Creating keycode diskettes

In addition to receiving a keycode diskette from Nortel Networks, a keycode diskette can be created onsite using the following methods:

- downloading a keycode from the Nortel Networks Keycode Distributor Server to a PC and creating a diskette (see “Using the Distributor Keycode Application” in this document for more information)
- entering a keycode manually using the commands in LD 143. Using this method, the keycode is entered as 21 lines of 16 characters. The keycode file is then saved to a 2 MB diskette in the floppy drive.
- entering a keycode manually in the Meridian 1 Software Installation Tool. Using this method, the keycode is entered as 21 lines of 16 characters. The keycode file is then saved to a 2 MB diskette in the floppy drive.
- All keycode files must be named keycode with no extension.

When the keycode diskette is created, the keycode is entered into the system:

- using the KNEW command in LD 143 or,
- using the Software Installation Tool

The keycode is activated on the next system sysload.
Replacing an IODU/C card

Use this procedure to replace a faulty IODU/C card with a new IODU/C card.

WARNING
Performing this procedure in a nonredundant system, such as 51C, will disrupt system operation. If possible, schedule the replacement at the lowest traffic time.

See the X11 Administration (553-3001-311) for a description of all maintenance commands, and the X11 System Messages Guide (553-3001-411) for interpreting system messages.

WARNING
Module covers are not hinged; do not let go of the cover. Lift the cover away from the module and set it out of your work area.

CAUTION
At some point in this procedure the system will warm start, causing a momentary interruption in call processing.
Replacing the IODU/C in a redundant system

Performing a data dump

Before starting this procedure, make a backup copy of the customer database on a 4MB diskette using the data dump routine:

1. Log into the system
2. Load the Equipment Data Dump Program (LD 43).
   LD 43 to load the program
3. When “EDD000” appears on the terminal, enter
   EDD to begin the data dump
4. When “DATADUMP COMPLETE” and “DATABASE BACKUP COMPLETE” appear on the terminal, enter
   **** to exit the program

CAUTION
If the data dump is not successful, do not continue; contact your technical support organization. A data dump problem must be corrected before proceeding.

To access the Core during the replacement procedure, connect a terminal to the J25 port on the I/O panel in the inactive Core Module or Core/Network Module. To communicate with the processor, you must use the following settings on the terminal:

9600 baud, 7 data, space parity, 1 stop bit, full duplex, XOFF

If you are using only one terminal or a switch box, switch the connection from Core to Core as needed.
Split the Cores

1. Verify that the disk drives are synchronized:
   - LD 137 to load the program
   - STAT to get the status of the disk drives

   If the disks are synchronized, proceed with step 2. If they are not synchronized, execute the SYNC command:
   - SYNC to synchronize the drives
   - **** to exit the program

2. Verify that the clock controller associated with the faulty IODU/C is inactive. If it is not, switch clock controllers:
   - LD 60 to load the program
   - SSCK to get the status of the clock controllers
   - SWCK to switch clock controllers (if necessary)
   - **** to exit the program

3. Verify that the IODU/C card you are replacing is on the inactive Core:
   - LD 135 to load the program
   - STAT CPU to check CPU status
   - TEST CPU to test the CPU

   If the IODU/C you are replacing is on the inactive Core, proceed with step 5. If the IODU/C you are replacing is not on the inactive Core, swap Cores and verify again:
   - SCPU to swap CPUs
   - STAT CPU to check CPU status

4. Verify that the faulty IODU/C is inactive. You may need to switch IODU/Cs:
   - LD 137 STAT Get the status of IODU/C.
   - SWAP Switch IODU/Cs (if necessary).

5. Set the MAINT/NORM switch on the CP card to MAINT on the active Core.
6 Set the ENB/DIS switch on all CNI cards to DIS on the inactive Core.

7 Perform the following three steps in uninterrupted sequence:
   • press and hold the MAN RST button on the CP card in the inactive Core
   • set the MAINT/NORM switch on the CP card in the inactive Core to MAINT
   • release the MAN RST button

Replace the IODU/C card

1 Set the ENB/DIS switch on the faulty IODU/C to DIS.

2 Unhook the locking devices and remove the IODU/C.

3 Remove the round 1/2” diameter IODU/C Security Device from the black round Security Device holder on the top right corner of the IODU/C card being replaced.

4 Put the IODU/C being replaced into a static bag and box.

5 With the Nortel Networks side facing upward, slide the Security Device between the security device holder and the holder clip in the new IODU/C card. Do not bend the clip more than necessary when inserting the Security Device. Ensure that the Security Device is securely in place.

6 Insert the new IODU/C into the following slots:
   • For NT5D21 Core/Net Modules, insert the IODU/C in slots 17, 18, and 19.
   • For NT9D11 Core/Network Modules and NT6D60 Core Modules, insert the IODU/C into slots 16, 17, and 18.

7 Lock the locking devices by pushing them gently towards the faceplate. Set the ENB/DIS switch to ENB.

8 Press the MAN RST button on the CP card.

9 Insert the CP Install diskette into Core/Net 0.
10 Press the MAN RST button on the CP card in Core/Net 0 to reboot the system and start the Software Installation Tool. (The terminal displays SYSLOAD messages during file loading. When SYSLOAD is completed, the Nortel Networks logo appears.)

11 When the Nortel Networks logo appears, press <CR> to continue.

12 Log into the system.

13 Enter the time and date, when prompted.

14 Initiate the installation by selecting the following prompt from the menu:
   <cr> <u> to Install menu

15 Remove the Install Utility diskette and insert the Keycode diskette, when prompted.
   <a> continue with keycode validation
   <y> to confirm that keycode matches CD-ROM release

16 Remove the Keycode diskette and re-insert the Install Utility diskette into the IODU/C floppy drive in Core/Net 0.

17 When the Install Menu appears, select the following options in sequence to copy the software from Core/Net 1 to Core/Net 0, install CP-software, ROMs, and transfer the database to the redundant disk:
   <o> to copy system software from the other Core/Net
   <a> to continue
   <a> to continue

When the software has copied successfully, you must install CP-software from the hard disk to Flash EEPROM, and install CP-BOOT ROM.

   <CR> press <CR> when you are ready to continue
   <y> to start installation
   <a> to continue with ROM upgrade
   <y> to start installing CP-BOOT ROM
   <a> to continue with ROM upgrade.

When the installation is complete, the Installation Status Summary screen appears.
Replacing an IODU/C card

When the Install Menu appears, install IOP-ROM:

- `<CR>` to return to the Install Menu
- `<f>` to install IOP-ROM only

When the Installation Status Summary screen appears:

- `<y>` to start installation
- `<y>` to continue installing IOP-ROM
- `<a>` to continue with ROM upgrade

When the installation is complete, the Installation Status Summary screen appears.

- `<CR>` to return to the Install Menu

When the Install Menu appears, install the database:

- `<d>` to install database only

When the Installation Status Summary screen appears:

- `<y>` to start installation
- `<a>` to continue transferring the database from the redundant disk

When the installation is complete, the Installation Status Summary screen appears.

- `<CR>` to return to the Install Menu

When the Install Menu appears, remove any diskettes in the floppy before rebooting the system:

- `<q>` to quit
- `<y>` to confirm quit
- `<a>` to reboot the system

Wait for “DONE” and then “INI” messages to be displayed before continuing.
Return the system to redundant mode

1. In the **inactive** Core, enable the NT6D65 CNI cards by setting the ENB/DIS faceplate switches to ENB.

2. In the **inactive** Core, perform the following steps in uninterrupted sequence:
   - press and release the MAN RST button
   - when SYS700 messages appear on CP LCD display, set the MAINT/NORM switch to NORM.

   Within 60 seconds, the LCD will display the following messages, confirming the process.

   **RUNNING ROM OS**
   **ENTERING CP VOTE**

   An “HWI534” message from the CPSI or SDI port indicates the start of memory synchronization. Within 10 minutes, an HWI533 message on the **inactive** Core CPSI or SDI TTY indicates the memory synchronization is taking place. Wait until the memory synchronization is complete.

3. Switch the NORM/MAINT switch on the **active** CP card to NORM.

4. Synchronize the disk drives:
   - **LD 137** to load the program
   - **SYNC** to synchronize the drives
   - **** to exit the program

   **Note:** Synchronization may take up to 50 minutes.
Replacing the IODU/C in an Option 51C

1. Perform a data dump in LD 43 (if possible).
2. Set the ENB/DIS switch on the faulty IODU/C to DIS.
3. Unhook the locking devices and remove the IODU/C.
4. Remove the round 1/2" diameter IODU/C Security Device from the black round Security Device holder on the top right corner of the IODU/C card being replaced.
5. Put the IODU/C being replaced into a static bag and box.
6. With the Nortel Networks side facing upward, slide the Security Device between the security device holder and the holder clip in the new IODU/C card. Do not bend the clip more than necessary when inserting the Security Device. Ensure that the Security Device is securely in place.
7. Insert the new IODU/C into the following slots:
   - For NT5D21 Core/Net Modules, insert the IODU/C in slots 17, 18, and 19.
   - For NT9D11 Core/Network Modules and NT6D60 Core Modules, insert the IODU/C into slots 16, 17, and 18.
8. Lock the locking devices by pushing them gently towards the faceplate. Set the ENB/DIS switch to ENB.
   - A blinking letter “E” and number “5” displayed indicates that a failure occurred. In that case, reseat the Security Device in its holder and reinsert the card.
9. Select the CP Install diskette which matches the Call Processor (CP) type on your system (68030, 68040, or 68040).
10. Press the MAN RST button on the CP card in the Core containing the replacement IODU/C.
    - The system will be booted from the floppy and the Install tool will be automatically invoked. When the Nortel Networks Logo screen appears, press <CR> to continue.
11. Log into the system and enter the time and date, when prompted.
12 Initiate the database installation by selecting the following command from the menu:

- `<u>` to Install menu

13 Remove the CP Install Program diskette and insert the Keycode diskette, when prompted.

- `<a>` to continue with keycode validation
- `<y>` to confirm that the keycode matches the CD-ROM release

14 When the Install Menu is displayed, select the following options in sequence when you are prompted to do so

- `<a>` to install software, CP-ROM, and IOP-ROM
- `<a>` to verify that the CD-ROM is now in drive
  The Installation Status Summary screen appears that lists the options to be installed.
- `<y>` Yes, start the installation
- `<a>` continue with upgrade

When the ROM installation screen appears, select the following prompts in sequence:

- `<a>` to install CP-ROM from hard disk
- `<a>` to continue with ROM upgrade

When all files are copied from the CD-ROM to hard disk, press `<CR>` to continue.

- `<a>` to install the IOP-ROM from hard disk
- `<y>` Yes, start installation
- `<a>` to continue with ROM upgrade

The Installation Status Summary screen appears. Verify that CD to disk, disk to ROM, CP-BOOTROM, and IOP-ROM were installed.

- `<cr>` press return to return to the Install Menu.
- `<q>` to quit (remove any diskettes from the floppy drive)
- `<y>` Yes, to confirm quit
Replacing an IODU/C card

To complete the IODU/C card upgrade, verify CPU and CNI status.

1. Log into the system.
2. Verify CPU and CNI functionality:
   - **LD 135** to load the overlay
   - **STAT CPU** to check the CPU status
   - **STAT CNI** to verify CNI functionality
   - **** to exit the program
3. Load the Equipment Data Dump Program (LD 43).
   - **LD 43** to load the program
4. When “EDD000” appears on the terminal, enter
   - **EDD** to begin the data dump
5. When “DATADUMP COMPLETE” and “DATABASE BACKUP COMPLETE” appear on the terminal, enter
   - **** to exit the program
6. Evaluate the number of call registers and telephone buffers that are configured for the system. Refer to *Capacity Engineering* (553-3001-149).

The IODU/C card replacement procedure is complete.
Replacing the security device

Use this procedure to replace the security device on the NT5D61 Input/Output Disk Unit with CD-ROM (IODU/C) Card.

The security device is a field removable component and is located in the upper right corner of an IODU/C card. The device does not contain feature or software release specific information, but it has a unique custom program necessary for each customer. It is intended to serve the customer through numerous upgrade and feature changes.

The security device is replaced only if such a replacement is suggested by maintenance and/or diagnostic programs.

**WARNING**
Performing this procedure in a nonredundant system, such as a 51C, will disrupt system operation. If possible, schedule the replacement at the lowest traffic time.

See the *X11 Administration* (553-3001-311) for a description of all maintenance commands, and the *X11 System Messages Guide* (553-3001-411) for interpreting system messages.

**WARNING**
Module covers are *not* hinged; do not let go of the cover. Lift the cover away from the module and set it out of your work area.
Replacing the security device on a redundant system

The procedure begins with the validation of the keycode against the existing security device.

1. To access the Core during the replacement procedure, connect a terminal to the J25 port on the I/O panel in the inactive Core Module or Core/Network Module. To communicate with the processor, you must use the following settings on the terminal:
   9600 baud, 7 data, space parity, 1 stop bit, full duplex, XOFF

   Note: If you are using only one terminal or a switch box, switch the connection from Core to Core as needed.

2. Use LD 135 to switch to the Core which contains the non-faulty security device.
   
   LD 135          to load the program
   SCPU            switch CPUs (if necessary)
   ****            exit LD 135

3. Insert the keycode diskette into the floppy drive on the IODU/C with the non-faulty security device.

4. In LD 143, print the pending keycode contents. Use “KSHO F0” if your keycode is on the diskette in the floppy drive on Core 0, or “KSHO F1” if your keycode is on the diskette in the floppy drive on Core 1:
   
   LD 143          to load the program
   KSHO F0         print the contents of the candidate keycode
   or
   KSHO F1

CAUTION
At some point in this procedure the system will warm start, causing a momentary interruption in call processing.
Perform the KDIF command. Use “KDIF F0 REC” if the keycode diskette is inserted in the floppy drive on Core 0, or “KDIF F1 REC” if the keycode is inserted in the floppy drive on Core 1:

- **KDIF F0 REC** to print the differences between the candidate and the current keycodes
- **KDIF F1 REC** to exit LD 143

**Place the system in split mode**

If you have a redundant system, you must put the system in split mode before activating the new keycode:

1. Be sure the Core or Core/Net module that contains the faulty security device is in standby (inactive) mode. You may need to switch CPs:

   **LD 135**
   **STAT CPU**
   **SCPU** to switch CPUs if necessary
   **** exit program

2. Verify that IODU/C that contains the faulty security device is in standby (inactive) mode. You may need to switch IODU/Cs.

   **LD 137**
   **STAT** Get the status of IODU/C
   **SWAP** Switch IODU/Cs if necessary
   **** exit program

3. In the active Core, set the CP card MAINT/NORM switch to MAINT.

4. In the inactive Core, disable the NT6D65 Core to Network Interface (CNI) cards by setting the ENB/DIS faceplate switches to DIS.

5. In the inactive Core, set the MAINT/NORM switch on the CP card to MAINT.

**Replace the faulty security device**

1. Set the ENB/DIS switch on the IODU/C with the faulty security device to DIS.

2. Unhook the locking devices and remove the IODU/C.
3. Remove the round 1/2” diameter IODU/C security device from the black round security device holder on the top right corner of the IODU/C card.

4. Locate the round 1/2” diameter IODU/C replacement security device.

5. Make sure the 8-digit NT SDID on the Keycode diskette matches the 8-digit NT SDID code on the replacement security device.

6. With the Nortel Networks side facing upward, slide the replacement security device between the security device holder and the holder clip. Do not bend the clip more than necessary when inserting the security device. Ensure that the security device is securely in place.

7. Reinsert the IODU/C into the following slots:
   - For NT5D21 Core/Net Modules, insert the IODU/C in slots 17, 18, and 19.
   - For NT9D11 Core/Network Modules and NT6D60 Core Modules, insert the IODU/C into slots 16, 17, and 18.

8. Lock the locking devices by pushing them gently towards the faceplate. Set the ENB/DIS switch to ENB.
   A blinking letter “E” and number “5” displayed indicates that a failure occurred. In that case, reseat the security device in its holder and reinsert the card.

9. Load overlay 143 to:
   - **LD 143** to load the Keycode Management overlay
   - **KNEW F1 or F0** to install the new keycode on the hard drive
   The uploaded keycode is validated against the security device, software version, release and issue. It will reside on the your hard disk, and be backed up on a floppy disk upon the next archive command.

10. If there are validation errors, refer to the *Fault Isolation* section.

11. If successful, exit the overlay and go the next step.
   - **Exit.**
   - **** to exit the program
**Return the system to redundant mode**

1. Enable the NT6D65 CNI cards by setting the ENB/DIS faceplate switch to ENB in the *inactive* Core.

2. Press and release the MAN RST button in the *inactive* Core.

3. Set the MAINT/NORM switch to NORM in the *inactive* Core. Memory shadowing is automatically restored after a short delay. Wait until memory shadowing is complete before continuing.

4. In the *active* Core, set the MAINT/NORM switch on the CP card to NORM.

**Synchronize the hard disks**

1. When the Nortel Networks logo appears, log into the system and enter the date and time.

2. Load LD 137 and synchronize the hard disks. Synchronization may take up to 50 minutes. To be sure that the contents of IODU/C 1 hard disk are copied to IODU/C 0 hard disk, verify that IODU/C 0 is disabled.

   **LD 137**

   STAT Get the status of the IODU/C and redundancy

   SYNC Enter "Yes" to synchronize disks. Wait until the memory synchronization successfully completes before continuing.

3. Get the status of the IODU/Cs and be sure IODU/C 0 is active. Switch if necessary.

   STAT Get the status of IODU/C and redundancy

   SWAP Switch IODU/C if necessary

   STAT CMDU Get the status of the IODU/Cs. Be sure the same IODU/C and CPU are active.

   **** exit program

4. Perform a data dump in LD 143.

The security replacement procedure is complete.
Replacing the security device on an Option 51C system

**WARNING**
Performing this procedure in a nonredundant system, such as 51C, will disrupt system operation. If possible, schedule the replacement at the lowest traffic time.

1. To access the Core during the replacement procedure, connect a terminal to the J25 port on the I/O panel in the Core Module or Core/Network Module. To communicate with the processor, you must use the following settings on the terminal:

   **9600 baud, 7 data, space parity, 1 stop bit, full duplex, XOFF**

2. Set the ENB/DIS switch on the IODU/C card to DIS.

3. Unhook the locking devices and remove the IODU/C card.

4. Remove the round 1/2” diameter security device from the black round security device holder on the top right corner of the IODU/C card.

5. Locate the round 1/2” diameter IODU/C replacement security device.

6. Make sure the 8-digit NT SDID on the Keycode diskette matches the 8-digit NT SDID on the replacement security device.

7. With the Nortel Networks side facing upward, slide the replacement security device between the security device holder and the holder clip. Do not bend the clip more than necessary when inserting the security device. Ensure that the security device is securely in place.

8. Reinsert the IODU/C into the following slots:
   - For NT5D21 Core/Net Modules, insert the IODU/C in slots 17, 18, and 19.
   - For NT9D11 Core/Network Modules and NT6D60 Core Modules, insert the IODU/C into slots 16, 17, and 18.
9 Lock the locking devices by pushing them gently towards the faceplate. Set the ENB/DIS switch to ENB.

A blinking letter “E” and number “5” displayed indicates that a failure occurred. In that case, reseat the security device in its holder and reinsert the card.

10 Insert the CP Install Program diskette that corresponds to your CP card (68030, 68040, or 68060) and press the MAN RST button on the CP card.

11 Press <CR> to continue.

12 Log into the system and enter the time and date, when prompted.

13 Initiate the database installation by selecting the following command from the menu:

<u> to Install menu

14 Remove the CP Install Program diskette and insert the Keycode diskette, when prompted.

<a> to continue with keycode validation

<y> to confirm that the keycode matches the CD-ROM release

Following keycode validation, the system erases all keycode files from the hard disk and replaces them with the new keycode.

When the Install Menu appears:

<k> to install Keycode only

Remove the diskette from the IODU/C.

<q> to quit (remove any diskettes from the floppy drive)

<y> Yes, to confirm quit

<a> to reboot the system

The system will automatically perform a sysload and several messages will appear on the system terminal. Wait for “DONE” and then “INI” messages to be displayed before continuing.

The Security Device replacement procedure is complete.
Database transfer

This section describes database transfer for systems upgrading to options 51C, 61C, or 81C with the IODU/C card. Typically, database transfer is performed in conjunction with a system upgrade. Refer to Hardware Upgrade Procedures (553-3001-258) for complete system upgrade procedures.

Database transfer is the process of transferring an existing system database to a 2 MB format that is compatible with the IODU/C card.

For systems equipped with MDU or SMDU cards running X11 release 21 or 18H (Phase 8), the database can be transferred using two different methods:

- Transfer the database using the Database Transfer Utility (this requires an “interim” IOP/CMDU card during the database transfer). Refer to “Using the Database Transfer Utility” on page 142.
- Cable the SMDU or MDU to the IODU/C card and downloading the database (refer to “Using the direct cabling method” on page 144).

For systems equipped with IOP/CMDU or separate IOP and CMDU cards running X11 release 21, the database is converted from a 4 MB format to a 2 MB format that is compatible with the IODU/C card using the Database Transfer Utility diskette (refer to “Using the Database Transfer Utility” on page 152). The Database Transfer Utility diskette is included in the upgrade package and is installed in the IOP/CMDU card.

Note: For Options 61C and 81C systems, the database can also be transferred using the Copy database command in the Software Installation Tool (refer to “Using the Copy database command” on page 153).
For systems running X11 16G (Phase 7) and equipped with NT8D69 MDU cards with 2 MB floppy drives, the Database Transfer Utility diskette is also used to convert the database to a 2 MB format that is compatible with the IODU/C (refer to “Databases on X11 release 16 G (Phase 7)” on page 154).

**Database transfer for Options 21E, 51, 61, 71, STE, NT, and XT systems**

For systems equipped with MDU or SMDU cards, the database can be transferred using **two different methods**:

- transfer the database using the Database Transfer Utility (this requires an “interim” IOP/CMDU card during the database transfer)
- cable the SMDU or MDU to the IODU/C card and downloading the database

**Using the Database Transfer Utility**

To perform this procedure, an interim NT5D20 IOP/CMDU and QMM42 security cartridge are required.

Before beginning this procedure:

- The system must be running X11 release 21 or 18H (Phase 8)
- For dual-CPU systems, the system must be in split mode with **Core 0 processing calls**.
- The target system must be installed and powered up.

1. Perform a data dump in LD 43 on the existing system.

2. In Core/Net 1 (Core/Net 0 for single CPU systems) of the target system, install the NT5D20 IOP/CMDU card into slot 17.

3. In Core/Net 1, install the Database Transfer Utility diskette, which corresponds to the existing (source) CP card, into the floppy drive on the IOP/CMDU card.

4. Press the MAN RST button on the CP card in Core/Net 1.
5 When the Nortel Networks Logo Screen appears on the terminal, the Database Transfer Utility has loaded. Press <CR> to continue.

**CAUTION**
When using the Database Transfer Utility, do not select options other than those specified by this procedure. Selecting any other options can result in operating system corruption.

6 When the Main Menu appears, select <d> To install Database only.

7 Select <c> to transfer the previous system database (DBMT). Follow all on-screen instructions. When DBMT is complete, press <CR> to return to the Main Menu.

8 Select <t> to go to the Tools Menu
   <s> to archive existing database
   <a> to continue with archive (insert 2MB diskette into the floppy drive in Core 1)
   <a> diskette is now in floppy drive in side 1

   The message “Database backup complete!” is displayed and the Tool menu reappears after the backup is successfully completed.

9 Remove the 2MB diskette containing the customer database from the IOP/CMDU floppy drive.

10 When the database is converted to 2 MB, place it in a safe place for use after the IOP/CMDU card is replaced with an IODU/C card, and continue with the system upgrade.

   The database transfer procedure is complete. You are now ready to install software.
Using the direct cabling method

Typically, database transfer is performed in conjunction with a system upgrade. Refer to the appropriate upgrade section in this document for complete system upgrade procedures.

Before beginning this procedure:

- The system being upgraded must be running X11 release 21 or 18H (Phase 8)
- The target system must be configured with a Core/Net module, Call Processor (CP) card, and Common Equipment Power Supply.
- For redundant systems, the system must be in split mode with CPU 0 processing calls.

CAUTION
For redundant systems, the direct cabling procedure must begin on CPU 0. For single CPU systems, a jumper change is required to change the SCSI bus address of the floppy drive on the MDU as it conflicts with the SCSI bus addresses of the drives on the IODU/C where the IODU/C resides on Core 0. The jumper change is not required on redundant systems where the IODU/C resides in Core 1. This is because the SCSI addressing on the IODU/C, which is dependent on the Core in which it resides, does not conflict with the MDU floppy drive SCSI address.

Note: To transfer the database using the direct cabling method, you will place the MDU (or SMDU and EMSI cards) into an empty network slot in the Core/Net 1 module. For redundant systems, the MDU (or SMDU and EMSI cards) is used in Core/Net 1 only. The database is copied from Core/Net 1 to Core/Net 0 using the Software Installation Tool.

CAUTION
Ensure that Core/Net 1 is powered down when installing the IODU/C and MDU/SMDU into the Core/Net backplane. Failure to power down the module may cause damage to the MDU or SMDU cards.
CAUTION
The database transfer procedure cannot be performed if two IODU/C cards are installed in the system.

IODU/C cabling

1 Shut down power to the Core/Net 1 module. For AC-powered systems, set the circuit breaker on the MPDU in the module to OFF (down position). For DC-powered systems, set the switch on the pedestal to OFF (down position).

2 Remove the IODU/C card from Core/Net 1.

3 Disconnect the NT5D54AA ribbon cable from the CD-ROM drive SCSI connector (see Figure 3 on page 145). Do not disconnect the cable from the IODU/C circuit board.

Figure 3
Location of NT5D54 cable on IODU/C card
4 Plug the male connector of the NT5D50AA ribbon cable into the NT5D54AA SCSI ribbon cable that was just disconnected. Make sure that the colored edges of both ribbon cables are lined up when connecting the cables (P1 to P1).

5 Route the other end of the NT5D50AA ribbon cable over the CD-ROM drive, past the IODU/C faceplate, to the empty network card slots where the MDU will be temporarily installed.

6 Install the IODU/C card into slot 17 of Core/Net 1.

**MDU cabling**

1 If the MDU or SMDU was stored in CPU 0 or network module, use the following steps to remove the MDU/SMDU:

   • Software disable the QPC584 MSI card, NT9D34 EMSI card, or QPC742 FDI card in the active CPU:
     
     LD 37 to load the program
     DIS MSI 0 to disable the card

   • Remove the floppy diskettes from the disk drives.
   • Label and disconnect cables from the faceplate of the MDU or SMDU.
   • Unhook the lock latches on the MDU/SMDU and gently pull the unit forward two or three inches.

*Note:* When removing an MDU, wait at least 30 seconds after unplugging the unit from the card slot before you remove it from the card cage. This allows the hard disk drive to stop spinning, and reduces the risk of damage to the drive.
2 Unplug the NTND1602 SCSI ribbon connector from the MDU/SMDU floppy drive A. Floppy drive A is at the top of the MDU/SMDU card.

**CAUTION**
Perform step 3 for Option 51C systems only. The jumper change is required to change the SCSI bus address of the floppy drive on the MDU as it conflicts with the SCSI bus addresses of the drives on the IODU/C where the IODU/C resides on Core 0. The jumper change is not required on redundant systems where the IODU/C resides in Core 1. This is because the SCSI addressing on the IODU/C, which is dependent on the Core in which it resides, does not conflict with the MDU floppy drive SCSI address.

3 **For Option 51C systems only**: Remove the 2-pin jumper located closest to the ribbon connector on floppy drive A (see Figure 4). The jumper block has 6 pins and three jumpers.

*Figure 4*
Option 51C 2-pin jumper location on MDU card

---

*2-pin jumper*
4 Plug the NT5D50AA ribbon cable P2 female connector into the floppy drive A connector on the MDU/SMDU (see Figure 5). Make sure that the colored edge of the ribbon cable is towards the floppy drive power connector. This connects the IODU/C to the MDU/SMDU floppy drive A.

Figure 5
Cabling the MDU to the IODU/C card

5 Install the MDU/SMDU into an empty network card slot in the Core/Net 1 module (see Figure 6). If the SMDU is used, you must also install the NT9D34 EMSI card next to the SMDU in a network slot of Core/Net 1. Connect the NT9D66 faceplate cable (J1) between the SMDU and EMSI cards.
6 Insert the B1 (4MB) customer database diskette previously archived, into the floppy drive A (top drive) of the MDU/SMDU.

7 Verify that the CP card is set to MAINT and install the card in slot 15 (the card occupies two slots).

8 Set the ENB/DIS switch on the IODU/C card to ENB (and EMSI if installed).

9 Insert the CP Install Program diskette that corresponds with the installed CP card type into IODU/C floppy drive.

10 Connect a terminal to the J25 CPSI port on Core/Net 0.

11 Apply power to the module.
   The system is now loading software from the floppy diskette and the terminal will display SYSLOAD messages during file loading. Wait for the Nortel Networks logo to appear after SYSLOAD has been completed.

12 When the Nortel Networks logo appears, press <CR> to continue.

13 Log into the system and enter the time and date, when prompted.
14 Initiate the database installation by selecting the following command from the menu:
   <u> to Install menu

15 Remove the CP Install Program diskette and insert the Keycode diskette, when prompted.
   <a> to continue with keycode validation
   <y> to confirm that the keycode matches the CD-ROM release

16 When the Install Menu appears, select the following options in sequence:
   <d> to install customer database only
   <f> to transfer the customer database from the MDU
   <a> to continue the database transfer

   Note: If the message SCSI002 is displayed (Unable to initialize floppy drive X), ensure that you only have one IODU/C installed in the system. Two IODU/C cards cannot be installed in the system during the database transfer procedure.

   <a> to transfer the database from the floppy to the hard disk (make sure customer database B1 diskette is installed in the floppy drive A on the MDU)
   <cr> to continue the Installation Status Summary menu appears to confirm database transfer
   <y> to start installation
   <a> Yes, transfer the database

   Database transfer begins. After the customer database is successfully transferred, the system displays “Success! Database Transferring complete”.
   <cr> Press Return to display the Installation Status Summary, which shows that the database was successfully transferred.
   <cr> Press return to return to the Install Menu.

Remove any diskettes from the floppy drive.

<q> When the Install Menu appears, select <q> to quit.
    Remove any
17 **Shut down power to Core/Net 1 module.**

*Note:* When removing the IODU/C card, wait at least 30 seconds before you remove it from the card cage. This allows the hard disk drive to stop spinning, and reduces the risk of damage to the drive.

18 Remove the IODU/C card and disconnect the ribbon cable NT5D50AA from the CD-ROM drive connector. Reinstall the NT5D54AA SCSI ribbon cable between the CD-ROM drive and the J9 motherboard connectors.

19 Reinstall the IODU/C into the card slot 17 and ensure that the ENB/DIS switch is set to ENB.

20 Insert the CP Install Program diskette that corresponds with the installed CP card into the IODU/C floppy drive (68030, 68040, or 68060).

21 Unplug and remove the MDU/SMDU from the network card slot of Core/Net and disconnect the NT5D50AA ribbon cable from the floppy disk drive A and reconnect the NTND1602 SCSI ribbon cable to the disk drive A. Unplug and remove the EMSI card from Core/Net module, if equipped.

22 Install the remaining Core/Net circuit cards and faceplate enable them. **Leave the CNI cards disabled** to ensure call processing is not disrupted on the active CPU.

23 Verify that the CP card faceplate switch is set to MAINT.

24 Apply power to the module.

The database transfer procedure is complete. You are now ready to install software.
Database transfer for Option 51C, 61C, 81, and 81C systems

For systems equipped with IOP/CMDU or separate IOP and CMDU cards, the database is transferred using:

- the Database Transfer Utility diskette
- the Software Installation Tool Copy database command (this method is supported for dual CPU systems only)

Using the Database Transfer Utility

Before beginning this procedure:

- The system must be running release 21 or later
- For redundant systems, the system must be in split mode with Core 0 processing calls.
- The target system must be installed and powered up.

1. Perform a data dump in LD 43.
2. Insert the Database Transfer Utility diskette which corresponds to your Call Processor type (68060, 68040, 68030) into the floppy drive.
3. Press the MAN RST button on the CP card in Core 1 (Core 0 for single CPU systems) to reboot the system and start the Transfer Utility Tool.

CAUTION

When using the Database Transfer Utility, only select options <d> To install Database only, <t> Tools Menu, and <s> To archive existing database. Selecting any other options can result in operating system corruption.
4 When the Transfer Utility Main Menu appears, select the following options in sequence:

- <t> to go to the Tools menu
- <s> to archive existing database
- <a> to continue with archive (insert 2MB diskette into the floppy drive in Core 1)
- <a> diskette is now in floppy drive in side 1

The message “Database backup complete!” is displayed and the Tool menu reappears after the backup is successfully completed.

5 Remove the 2MB diskette containing the customer database from the IOP/CMDU floppy drive and place it in a safe place for use after Core 1 is converted to Core/Net 1 with an IODU/C. Do not reboot the system at this point.

The database transfer procedure is complete. Continue with the system upgrade.

**Using the *Copy database* command**

For **Options 61C and 81C systems**, the database can also be transferred using the *Copy database* command in the Software Installation Tool.

Before beginning this procedure:

- The existing system must be running release 21 or later.
- The system must be in split mode with Core 0 processing calls.
- The IODU/C and Call Processor cards must be installed in the target system.
- The NTND13 IOP cable must be connected to the IOP/CMDU card in Core 0 and the IODU/C card in Core 1.
- Core 1 is powered up.
1 Place the Install Program diskette that corresponds with your CP type into the IODU/C in Core 1.

2 Install the CD-ROM into the CD drive.

3 Press and release the MAN RST button in Core 1. This will reboot the system.

A sysload will begin (cold start). Wait for the Nortel Networks Logo to appear on the terminal before proceeding. Press <CR> to continue.

The Install Main Menu is displayed after the system-check passes. The next menu prompts you to continue with the Install or go to the Tools Menu.

4 Select option <u> to go to the Install menu.

5 Insert the Keycode diskette into the disk drive and select option <a>.

6 When the Install Main Menu appears, select the following options in sequence to copy the customer database from the IOP/CMDU in Core 0 to the IODU/C in Core 1.

   <d> to install database only
   <d> to copy the database
   <y> to confirm installation status summary
   <a> to confirm database copy

7 Select the following options to quit and reload the system:

   <q> to quit
   <y> to confirm quit
   <a> to reboot the system

Wait for “DONE” and then “INI” messages to be displayed before continuing.

The database transfer procedure is complete. You are now ready to install software.

**Databases on X11 release 16 G (Phase 7)**

Use the following procedure if your system is equipped with NT8D69 MDU cards running X11 release 16G (Phase 7) software.
Before beginning this procedure:

- Perform a data dump in LD 43 on the existing system.
- Upgrade the existing system to Meridian Options 51C, 61C, or 81C using the procedures in *Hardware Upgrade Procedures* (553-3001-258).
- Install X11 release software.

1. Insert the Database Transfer Utility diskette into the IODU/C floppy drive.
2. Press the MAN RST button on the CP card to reboot the system and start the Software Installation Tool. When the sysload is complete, the Nortel Networks logo appears.
3. When the Nortel Networks logo appears, press <CR> to continue.
4. Log in the system and enter the time and date, when prompted.
5. Initiate the database installation by selecting the following command from the menu:
   - <u> to Install menu
6. Remove the CP Install Program diskette and insert the Keycode diskette, when prompted.
   - <a> to continue with keycode validation
   - <y> to confirm that the keycode matches the CD-ROM release
7. When the Install Menu appears, select the following options in sequence:
   - <d> to install customer database only
   - <c> to transfer the previous system database (DBMT)
   When DBMT is complete, press <CR> to transfer the database from 2 MB floppy to hard disk.
   Insert the source database 2 MB disk (B1) into the floppy drive. The Installation Status Summary table appears.
   - <a> to start installation
   - <a> to transfer the database
The system transfers the database to hard disk and the Installation Status Summary table re-appears.

<cr> to return to the Install Menu
<q> to quit
<y> to confirm quit

Remove the 2 MB database diskette from the floppy drive.
<a> to reboot the system

The database transfer procedure is complete.
IODU/C Software Installation Tool

This chapter details the screen displays and options of the CD-ROM Software Installation Tool (hereafter referred to as "Software Installation Tool") that is compatible on Options 51C, 61C, 81, and 81C systems equipped with the NT5D61 Input/Output Disk Unit with CD-ROM (IODU/C).

This tool is based on the existing Software Installation Tool, but has notable differences in menus as well as new functionality to support installation of software from CD-ROM, copying of system software from Core to Core, copying of database from Core to Core, and Keycode installation.

The IODU/C card no longer uses a Security Cartridge, but instead uses both a Security Device and an electronic keycode file. This keycode file is stored on a 2MB diskette and must be inserted into the IODU/C floppy drive and authenticated each time the Software Installation Tool is loaded and the Install Menu is accessed.

On systems equipped with an IODU/C, the database is stored on 2MB diskettes, not 4MB diskettes. A Database Transfer Utility diskette, specific to Call Processor type, is available to convert a 4MB database to a 2MB database. Refer to Software Conversion Procedures (553-2001-320) and Hardware Replacement (553-3001-520) for procedures on upgrading from systems equipped with IOP and CMDU or IOP/CMDU cards to IODU/C.

The Tools Menu has new options for finding the CD-ROM status (option <g>), printing the Keycode (option <h>), printing information about the Security Device (option <i>), checking the customer-specific CD-ROM data (<j>), manually creating a Keycode diskette (<k>), and archiving the database (<s>).
Do not turn off the system during the installation process. If you need to quit the installation process, do so from within the Software Installation Tool before powering off the system.

Read the entire procedure before attempting to perform an installation.

Before the Software Installation Tool is activated, verify that the system is in split mode (not applicable for Option 51C) and that a terminal is connected to CPSI port J25 on the I/O panel (in the inactive Core for dual CPU systems). Option 51C systems will be taken out of service.

To activate the Software Installation Tool, insert the Install diskette specific to your Call Processor type and the CD-ROM containing system software (if you will be installing that component). Press the MAN RST button on the CP card in the same Core.

The IODU/C Software Installation Tool requires the following items:

- 2MB diskettes (used to store, backup, and restore the database)
- an Install diskette specific to the system’s Call Processor card
- a Keycode diskette
- a CD-ROM containing system software

**Note:** If you will be installing system software from CD-ROM (options <a>, <b>, or <c> from the Install Menu), then insert the CD into the CD-ROM drive before loading the Software Installation Tool.

**CAUTION**

The screens shown in this procedure are examples. They are not intended to exactly represent the displays that will appear for your system, nor do the choices entered represent those you should necessarily choose. Be sure to watch the terminal display, and follow the on-screen instructions.

Pay close attention to the menus when they appear; they display the options available at any given stage.
Status Summary Charts

Status Summary Charts are displayed for the purpose of informing the user about what items will be installed or have been installed. This example is shown when option <b> (all components) is chosen from the Install Menu.

*Note:* Your screen may differ from this example.

<table>
<thead>
<tr>
<th>Option</th>
<th>Choice</th>
<th>Status</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>SW: CD to disk</td>
<td>yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SW: disk to ROM</td>
<td>yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Database</td>
<td>yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CP-BOOTROM</td>
<td>yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>IOP-ROM</td>
<td>yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>from xxxx to xxxx</td>
<td></td>
</tr>
</tbody>
</table>

Please enter:
<CR> -> <y> - Yes, start Installation.
<n> - No, stop Installation. Return to the Main Menu.

Enter Choice> y

The possible values and meanings for each column are defined below.

— Choice
  * yes indicates the item will be installed
  * no indicates the item was not selected, and will not be updated.
— Status
  • **quit** indicates the quit option was used, and the process was exited.
  • **ok** indicates the choice was installed successfully.
  • **error** indicates the installation was not successful. A system message is given when the Software Installation Tool encounters a problem. Follow the actions required by the message.
  • **ignore** applies to the CP ROM and IOP-ROM upgrade only. This appears when the process was exited when asked to replace a release and issue with the same release and issue.
  • **blank** indicates the status is not yet determined if Choice = Yes. If Choice = No, the field remains blank.

— Comment
  • **from rel <number> to rel <number>** gives the Source and Target release and issue numbers.

**Messages**

When the Software Installation Tool encounters a problem, a system message appears on the terminal display. These messages fall into two categories: warning and non-warning.

Warning messages are not critical errors. The Software Installation Tool proceeds with the installation following the appearance of this message. Refer to *X11 Administration* (553-3001-311) for details regarding these messages.

Non-warning messages appear when a critical problem is encountered. The Software Installation Tool stops the process, and an action is recommended. When the action is complete, the Software Installation Tool can be restarted. In some cases, the tool allows you to restart by pressing the carriage return <CR>.
Introductory Screen

The first screen that appears after loading the NT5D61 Software Installation Tool is the Nortel Networks Logo Screen shown below.

![Introductory Screen Diagram]
The Main menu screen is displayed after the user presses <CR> from the NT Logo Screen. From this screen, the user may select option <u> to go to the Install Menu, or <t> to go to the Tools Menu. Alternately, option <q> to quit is available at this screen.

The Software Installation Tool will install or upgrade Meridian-1 System Software, Database and the PE-ROM (both CP and IOP ROM). You will be prompted throughout the installation and given the opportunity to quit at any time.

Please enter:
<CR>--> <u> - To Install menu.
<t> - To Tools menu.
<q> - Quit.

Enter choice > u
Install Menu

Note: A Keycode diskette is required before accessing the Install Menu.

Before the Install Menu screen is displayed, two intermediary screens shown below prompts the user to insert their Keycode diskette for validation against the Security Device.

```
Nortel Meridian - 1 Software/Database/PEROM CDROM INSTALL Tool (x11)
Please insert the diskette with the keycode file into the floppy drive.
Please enter:
<CR>--> <a> - Continue with the keycode validation
      (the keycode diskette is in the floppy drive).
      <q> - Quit.

Enter Choice > a
```

```
Nortel Meridian - 1 Software/Database/PEROM CDROM INSTALL Tool (x11)
Please confirm that this keycode matches the CDROM Release
Please enter:
<CR>--> <y> - Yes, the keycode matches. Go on to Install Menu.
      <n> - No, the keycode does not match. Try another keycode diskette.

Enter Choice > y
```
Following successful Keycode validation, the Install Menu screen is displayed, as shown below.

**Note:** If the Software Installation Tool is loaded on a Core equipped with an NT5D61BA IODU/C (which lacks a CD-ROM drive), options <a>, <b>, and <c> will not appear.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;a&gt;</td>
<td>To install Software, CP-BOOTROM, IOP-ROM.</td>
</tr>
<tr>
<td>&lt;b&gt;</td>
<td>To install Software, Database, CP-BOOTROM, IOP-ROM.</td>
</tr>
<tr>
<td>&lt;c&gt;</td>
<td>To install Software only.</td>
</tr>
<tr>
<td>&lt;d&gt;</td>
<td>To install Database only.</td>
</tr>
<tr>
<td>&lt;e&gt;</td>
<td>To install CP-BOOTROM only.</td>
</tr>
<tr>
<td>&lt;f&gt;</td>
<td>To install IOP-ROM only.</td>
</tr>
<tr>
<td>&lt;g&gt;</td>
<td>To reinstall CP-Software.</td>
</tr>
<tr>
<td>&lt;o&gt;</td>
<td>To copy System Software from the other Core.</td>
</tr>
<tr>
<td>&lt;t&gt;</td>
<td>To go to the Tools menu.</td>
</tr>
<tr>
<td>&lt;k&gt;</td>
<td>To install Keycode only. For Feature Expansion, use OVL143.</td>
</tr>
<tr>
<td>&lt;q&gt;</td>
<td>Quit.</td>
</tr>
</tbody>
</table>

Enter Choice >

Each option from the Install Menu is described in the following pages.
Installing Software, CP-BOOTROM, and IOP-ROM

*Note:* For dual-CPU systems, verify that the system is operating in split mode before activating the Software Installation Tool.

This option is selected for the sequential installation of software, CP-BOOTROM, and IOP-ROM. This option differs from option <b> in that the database is not installed. Use option <a> when going to a later X11 release or for a software upissue.

Installing Software, Database, CP-BOOT ROM, and IOP-ROM

*Note:* For dual-CPU systems, verify that the system is operating in split mode before activating the Software Installation Tool.

This option is selected when you wish to sequentially install all components - software, database, CP-BOOTROM, and IOP-ROM.

Option <b> is used during the upgrade procedures from NT5D20 IOP/CMDU, NT6D63 IOP and NT6D64 CMDU, NT9D33 SMDU, NTND16 FDU, NT8D69 MDU, and NTND16 MDU cards to NT5D61 IODU/C cards.

Installing Software only

*Note:* For dual-CPU systems, verify that the system is operating in split mode before activating the Software Installation Tool.

This option is selected when you wish to install system software from the CD-ROM to the hard drive. When selecting option <c>, IOP-ROM and CP-BOOTROM are not installed.
Installing Database only

Note: For dual-CPU systems, verify that the system is operating in split mode before activating the Software Installation Tool.

The Database Menu of the Software Installation Tool is accessed by the <d> option on the Install Menu. The following options are available for installing a database:

- Option <a> is to install the backup customer database from one or more 2MB diskettes.
- Option <b> allows installation from the CD-ROM containing the default database. This option is used on new systems which have no existing database.
- Option <d> copies the existing database from the redundant Core. This option is used when the database has already been installed on one Core. This option is used when upgrading from IOP/CMDU to IODU/C cards.
• Option <e> displays the version and issue of the current database residing on the Core. If database files are missing, error messages will be printed.

**CAUTION**
Before upgrading the system database, be sure a backup of the previous (source) database is on hand. Should any problems arise, it may be necessary to return to the previous database.

**Installing CP-BOOT ROM**

*Note:* Installation of CP-BOOTROM is available on systems with NT9D19, NT5D10, and NT5D03 Call Processor cards only. For systems with the NT6D66 Call Processor card, CP-ROM is installed instead of CP-BOOTROM. See page 167 for installing CP-ROM on a system equipped with an NT6D66.

*Note:* For dual-CPU systems, verify that the system is operating in split mode before activating the Software Installation Tool.

Option <e> is for installing new CP-BOOTROM. This option is used to install CP-BOOTROM while on Core 0 in a software upgrade, when software has already been installed using options <a> or <b> on Core 1, and software has already been copied onto Core 0 using option <o>.

The next screen displayed after selecting option <e> will show the version of CP-BOOTROM being replaced and version being installed, and the card slot where the CP-BOOTROM is being installed. The user is prompted to select <a> to continue with the CP-BOOTROM upgrade.

**Installing CP-ROM**

*Note:* Installation of CP-ROM is available on systems with NT6D66 Call Processor cards only. For systems with the NT9D19, NT5D10, or NT5D03 Call Processor cards, CP-BOOTROM is installed instead of CP-BOOTROM. See page 167 for installing CP-ROM on a system equipped with an NT6D66.
Note: For dual-CPU systems, verify that the system is operating in split mode before activating the Software Installation Tool.

Option <e> is for installing new CP-ROM. This option is used to install CP-ROM while on Core 0 in a software upgrade, when software has already been installed using options <a> or <b> on Core 1, and software has already been copied onto Core 0 using option <o>.

The next screen displayed after selecting option <e> will prompt the user to choose whether to install the CP-ROM from the hard disk (option <a>), or from CD-ROM (option <b>). If software has just been installed successfully, then option <a> should be used. However, if software was not installed, select option <b> to install from CD-ROM.

Installing IOP-ROM

Note: For dual-CPU systems, verify that the system is operating in split mode before activating the Software Installation Tool.

Option <f> is for installing new IOP-ROM. This option is used to install IOP-ROM while on Core 0 in a software upgrade, when software has already been installed using options <a> or <b> on Core 1, and software has already been copied onto Core 0 using option <o>, and CP-BOOTROM has been installed using option <e>.

The next screen displayed after selecting option <f> will prompt the user to choose whether to install the IOP-ROM from the hard disk (option <a>), or from CD-ROM (option <b>). If software has just been installed successfully, then option <a> should be used. However, if software was not installed, select option <b> to install from CD-ROM.

The next screen displayed after selecting option <f> will show the version of IOP-ROM being replaced and version being installed, and the card slot where the IOP-ROM is being installed. The user is prompted to select <a> to continue with the IOP-ROM upgrade.
Reinstalling CP-Software

*Note:* For dual-CPU systems, verify that the system is operating in split mode before activating the Software Installation Tool.

This option is used if a flash programming error occurs during software installation through options <a>, <b>, or <c>. Option <g>, which assumes that software files have already been installed on the hard disk, copies these files from the hard disk to the Flash EEPROM.

To copy system software from the other Core

*Note:* For dual-CPU systems, verify that the system is operating in split mode before activating the Software Installation Tool.

Option <o> is used during a software upgrade when software has already been installed on Core 1, and the Software Installation Tool has been loaded on Core 0.

*Note:* This option does not perform the installation of CP-BOOTROM (option <e>) or IOP-ROM (option <f>).

To go to the Tools Menu

Option <t> displays the Tools Menu and its options, which are described beginning on page 171.

To Install Keycode only

Option <k> is used when you wish to replace an existing Keycode.

To quit

*Note:* For dual-CPU systems, verify that the system is operating in split mode before activating the Software Installation Tool.

Throughout the installation process, the option to quit is always available. Quitting with the Software Installation Tool quit commands is preferable to pressing the MAN RST button on the CP card, since quitting from the tool will erase unneeded temporary files.
When you are done using the NT5D61 Software Install Tool remove the diskette from the IODU/C and select option <q> to quit from the Installation menu. The terminal displays a confirmation to quit. Pressing <y> confirms the quit.

```
Nortel Meridian - 1 Software/Database/PEROM CDROM INSTALL Tool (x11)

You selected to Quit. Please confirm.

Please enter:
<CR>-->
<y> - Yes, Quit.
<n> - No, DO NOT Quit.

Enter choice > y
```

The final screen displayed before quitting reminds the user that the Install diskette should be removed from the IODU/C floppy drive before pressing <a> to reboot the system.

```
Nortel Meridian - 1 Software/Database/PEROM CDROM INSTALL Tool (x11)

You have selected to Quit the Software Installation Tool
You may reboot the system or return to the Main Menu.
Before rebooting the system, remove Install diskette from the floppy drive.

----------------------------------------------
DO NOT REBOOT USING BUTTON!!
----------------------------------------------

Please enter:
<a> - Reboot the system.
<CR>-->
<m> - Return to the Main menu.

Enter Choice > a
```
Tools Menu

To load the Software Installation Tool which contains the Tools Menu, insert the Install diskette which is compatible with your Call Processor card. Press the MAN RST button on the CP card to load the tool.

The first screen that appears after loading the NT5D61 Software Installation Tool is the Nortel Networks Logo Screen shown below.

```
Nortel Meridian - 1  Software/Database/PEROM CDROM INSTALL Tool (x11)
* * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * *
* * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * *
* * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * *
* * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * *
* * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * *
* * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * *
Nortel — Meridian 1 Install Tool (x11)
* * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * *
* * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * *
* * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * *
* * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * *
* * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * *
* * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * *
* * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * *
* * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * *
* * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * *
Copyright 1992 - 1997 Nortel, Inc.
Please press <CR> when ready . . .
```
This screen is displayed after the user presses <CR> from the Nortel Networks Logo Screen. From this screen, selecting option <t> brings the user to the Tools Menu.

Note: Insertion of the Keycode diskette is not required for accessing the Tools Menu.
The Tools Menu has new options for finding the CD-ROM status (option <g>), printing the Keycode (option <h>), printing information about the Security Device (option <i>), checking the customer-specific CD-ROM data (<j>), manually creating a Keycode diskette (<k>), and archiving the database (<s>).

The Tools Menu is displayed below.

```
Nortel Meridian - 1 Software/Database/PEROM CDROM INSTALL Tool (x11)

TOOLS MENU

This is the Tools Menu for Install. You can select the tool that is appropriate. Please select one of the options below.

Please enter:
<CR>-->
  <a> - To set the system date and time.
  <b> - To partition the hard disk.
  <c> - To display the partition size of hard disk.
  <d> - To regenerate PDT Password.
  <g> - To print CDROM content.
  <h> - To print Keycode content.
  <i> - To print Security Device content.
  <j> - To Check the customer specific part of CDROM.
  <k> - To manually create Keycode floppy diskette.
  <r> - To install Keycode only.
  <s> - To archive existing database.
  <z> - To check MDU connection.
  <m> - To return to the Main Menu

Enter choice >
```

Each option from the Tools Menu is described in the following pages.
Setting the system date and time

This option is used to change the system date and time for the system’s internal clock. The correct date and time will ensure that files are time-stamped accurately.

Partitioning the hard disk

Note: Option <b> requires a password, and should only be performed by Nortel Networks support personnel.

WARNING
Partitioning a disk erases all files from it.
Displaying the hard disk partition size

Option <c> displays the partition sizes of the hard disk. The manufacturer and model number of the hard disk are also displayed.

<table>
<thead>
<tr>
<th>IODU 0</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unprotected Part Size:30MB, Sectors: 60000</td>
</tr>
<tr>
<td>Spare Part Size:30MB, Sectors: 60000</td>
</tr>
<tr>
<td>CardId Part Size:1MB, Sectors: 2000</td>
</tr>
<tr>
<td>Protected Part Size:60MB, Sectors: 120000</td>
</tr>
</tbody>
</table>

Regenerate the PDT password

Note: Option <d> requires a password, and should only be performed by Nortel Networks support personnel.

To print the CD-ROM content

Option <g> is used to find whether a CD-ROM exists on each IODU/C, and whether its sectors are readable. After selecting <g>, three options are available:

- **Fast** readability test, which takes about 17 seconds for each CD-ROM and reads 1/30th of the CD-ROM sectors.
- **Extensive** readability test, which takes about 3 minutes for each CD-ROM and reads 1/4th of the CD-ROM sectors.
- **Total** readability test, which takes about 6 minutes for each CD-ROM and reads all sectors of the CD-ROMs.

Note: The failure of a CD-ROM drive to read a known good CD-ROM may indicate a problem with the CD-ROM drive.
To print the Keycode content

Option <h> is used when you wish to display the information contained in the current Keycode. The information displayed includes machine type, software version, ISM limits, and which feature packages are enabled.

| System Serial Number | : 46379 |
| Software Version     | : 1811 |
| System Type          | : Option 61C |
| Call Processor       | : CP68030 |
| Release              | : 23 |
| Issue                | : 30G |
| NTI Order Number     | : 000000000000 |
| NT SDID - 1          | : 00000000 |
| NT SDID - 2          | : 00000000 |
| Date and Time of Manufacture | : 06/03/1998 - 14:53:38 |

Note: ( ) indicates that information is not available

ISM Limits:

| Loop Limit | : 32 |
| Sys TNs Limit | : 32767 |
| ACD Agt Limit | : 32767 |
| ACD DNs Limit | : 24000 |
| AST Limit | : 32767 |
| DSL Limit | : 100 |
| LTID Limit | : 100 |
| DCH Limit | : 64 |
| AML Limit | : 16 |
| MPH DSL Limit | : 100 |
| RAN CON Limit | : 32767 |
| RAN RTE Limit | : 512 |
| MUS CON Limit | : 1000 |
| Brand Index | : 1 |

Options Packages:

0-2 4-5 7-25 28-29 232-55 57-65
67 70-77 79-81 84 86 88-93
95 98-105 107-109 111 113-121 125
127 129 132-134 136 139-140 145-151
153-155 157-160 162 164 170 172-175
178-181 186 191-192 196 202-212 214-216
218-219 222-225 227-229 231 233-235 240
242-243 245-248 250-251 253-256 258-259 262-263
286 290-293 296-297 301-303 305-310 313-316
321 323-324 327-335

553-7745
To print the Security Device content
Option <i> shows specific information about the Security Device, such as Serial Number. This enables the user to find information about the Security Device without removing the NT5D61 IODU/C card.

<table>
<thead>
<tr>
<th>Engineering Code (Side x)</th>
<th>:NT5D61AA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Card Serial Number</td>
<td>:06NNTM1831RRC3 IOP</td>
</tr>
<tr>
<td>NT SDID</td>
<td>:20000080</td>
</tr>
<tr>
<td>Security Device Type</td>
<td>:NT_TCH</td>
</tr>
<tr>
<td>System Serial Number</td>
<td>:46379</td>
</tr>
</tbody>
</table>

To check the customer-specific part of the CD-ROM
Option <j> is used to check the readability of the Keycode-specified system software on the CD-ROM drive. Once all files have been checked successfully, the message “Checking directory /cdx/xxxx_DMR.Nxx ended successfully” is displayed to indicate completion.

To manually create a Keycode diskette
Option <k> is used to manually type in a keycode and save it to a 2MB diskette. Upon selecting this option, you may enter the characters into 21 Keycode entry lines of 16 characters each, which will compose the Keycode file to be saved on a 2MB diskette in the floppy drive.

Characters may be entered on the Keycode entry lines in one of two ways:

- manually entering each 16-character line followed by a <CR>
- “pasting” each individual 16-character line, then pressing <CR> (available on a PC running Windows 95®, using the Copy command (Control-C) to copy a line of characters from a keycode file, positioning the cursor on the current Keycode entry line, and using the Paste command (Control-V) to paste the line).

If a line is entered which does not have 16 characters, a message will be displayed informing the user to reenter the line correctly.

To install Keycode only
Option <r> is used when you wish to replace an existing Keycode.
To archive the existing database

Option <s> is one of the methods (the ABKO and BKO commands from overlay 143 are other methods) that is available to backup the customer database to 2MB diskettes. The size of the backup files and the estimated number of 2MB diskettes required to store the database will be displayed.

To check MDU connection

Option <z> tests the connection between a connected MDU and IODU/C.

To return to the Main Menu

Option <m> is selected to return the user from the Tools Menu to the Main Menu, where the user may select to quit (<q>) or go to the Install Menu (<u>).
Fault isolation

For a description of IODU/C related system messages, refer to the “System messages” on page 183 section.

<table>
<thead>
<tr>
<th>System Behavior</th>
<th>Possible Cause</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. The Install Program doesn’t boot, and the system goes into a continuous sysload.</td>
<td>1. The Install diskette doesn’t match the CP card in the system.</td>
<td>1. Insert the Install diskette that matches the CP card in the system.</td>
</tr>
<tr>
<td>2. The Install menu does not appear, and the following system message is received:</td>
<td>2. a) The keycode doesn’t match the CP card in the system.</td>
<td>2. a) Insert a keycode diskette that matches the CP card in the system.</td>
</tr>
<tr>
<td>a) INST0170</td>
<td>b) The keycode doesn’t match the Security Device(s) in the system.</td>
<td>b) Check the SDID label on the keycode diskette to ensure it matches the SDID of the system.</td>
</tr>
<tr>
<td>b) System message received SRPT4613</td>
<td>c) The keycode file is not named correctly.</td>
<td>c) The keycode must be named: “keycode.kcd”</td>
</tr>
<tr>
<td>c) System message received SRPT4627</td>
<td></td>
<td></td>
</tr>
<tr>
<td>System Behavior</td>
<td>Possible Cause</td>
<td>Corrective Action</td>
</tr>
<tr>
<td>--------------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>3. Unable to download system software from the CD ROM, and:</td>
<td>3. The keycode doesn’t match the Release and Issue of software on the CD ROM.</td>
<td>3. a) Replace either the CD ROM or the keycode.</td>
</tr>
<tr>
<td>a) System message received INST0092</td>
<td>b) The CD ROM is defective.</td>
<td>b) Replace the CD ROM.</td>
</tr>
<tr>
<td>b) System message received INST0027</td>
<td>c) The CD ROM drive is defective.</td>
<td>c) Replace the IODU/C card.</td>
</tr>
<tr>
<td>c) CD ROM LED doesn’t flicker.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4. In LD 143, the keycode fails the validation check during KUPL.</td>
<td>4. The keycode doesn’t match the Security Device(s) in the system.</td>
<td>4. a1) Check the SDID on the keycode diskette label to ensure it matches the system SDID.</td>
</tr>
<tr>
<td>a) System messages received: SRPT4613, and CCBR015</td>
<td></td>
<td>a2) Check the SDID that the keycode was made for in LD 143 using “KSHO F0”.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>a3) Check the Security Device(s) in LD 137 using “SDID”.</td>
</tr>
<tr>
<td>System Behavior</td>
<td>Possible Cause</td>
<td>Corrective Action</td>
</tr>
<tr>
<td>--------------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>5. In LD 143, the keycode fails the validation check during KNEW.</td>
<td>5.</td>
<td>5.</td>
</tr>
<tr>
<td>a) System message received INST0170</td>
<td>a) The keycode doesn’t match the CP card in the system.</td>
<td>a) If upgrading CP card, use the software Install program.</td>
</tr>
<tr>
<td>b) System messages received: SRPT4599, and CCBR017</td>
<td>b) The keycode doesn’t match the Release and Issue of software in the system.</td>
<td>b) If upgrading software Release and Issue, use the software Install program.</td>
</tr>
<tr>
<td>c) System messages received: SRPT4613, and CCBR0015</td>
<td>c) The keycode doesn’t match the Security Device(s) in the system.</td>
<td>c) See above: 4.a1, 4.a2, and 4.a3.</td>
</tr>
<tr>
<td>d) System messages received: SRPT4627, and CCBR013</td>
<td>d) The keycode file is not named correctly.</td>
<td>d) The keycode file must be named: “keycode.kcd”</td>
</tr>
<tr>
<td>6. The keycode fails the validation check during Sysload, and the system enters</td>
<td>6.</td>
<td>6.</td>
</tr>
<tr>
<td>a continuous Sysload loop.</td>
<td>a) The keycode file is corrupt.</td>
<td>a) Reinstall the keycode.</td>
</tr>
<tr>
<td>b) The Security Device(s) are damaged or missing.</td>
<td>b) The Security Device(s) are damaged or missing.</td>
<td>b) Make sure that the Security Device(s) are properly installed.</td>
</tr>
<tr>
<td>7. When in LD 137 running the “SDID” command:</td>
<td>7.</td>
<td>7.</td>
</tr>
<tr>
<td>a) The contents fail to print for a Security Device.</td>
<td>a) The Security Device(s) are damaged or missing.</td>
<td>a) Make sure that the Security Device(s) are properly installed.</td>
</tr>
<tr>
<td>8. The system suspends access to the 2MB floppy diskette drive:</td>
<td>8.</td>
<td>8.</td>
</tr>
<tr>
<td>a) System message received SCSI0117</td>
<td>a) A “non-2MB” diskette has been detected in the floppy drive.</td>
<td>a) Replace the diskette with a formatted 2MB floppy diskette.</td>
</tr>
</tbody>
</table>
## System messages

This section describes the following types of IODU/C-specific system messages:

- Software Error Monitor (BUG) messages on page 183.
- Keycode Management (CCBR) messages on page 184.
- Core Common Equipment Diagnostic (CCED) messages on page 185.
- Core Input/Output Diagnostic (CIOC) messages on page 186.
- Installation (INST) messages on page 186.
- Small Computer System Interface (SCSI) messages on page 191.
- System Reports (SRPT) messages on page 191.
- Tape Emulation (TEMU) messages on page 193.

### Table 10
**Software Error Monitor (BUG) messages**

<table>
<thead>
<tr>
<th>Message number</th>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>BUG9098</td>
<td>%s Software error.</td>
</tr>
<tr>
<td>BUG9099</td>
<td>Failed to access CP-IOP interface, side %d.</td>
</tr>
<tr>
<td>BUG9100</td>
<td>cdromFsLib: pVolDesc is NULL in %s.</td>
</tr>
<tr>
<td>BUG9101</td>
<td>cdromFsLib: pSecBuf is NULL in %s.</td>
</tr>
<tr>
<td>BUG9102</td>
<td>cdromFsLib: pVDList is NULL in %s.</td>
</tr>
<tr>
<td>BUG9103</td>
<td>cdromFsLib: SEC_BUF_MAG Magic number-%d is not equal to magic number-%d in %s.</td>
</tr>
</tbody>
</table>
### Table 10
Software Error Monitor (BUG) messages

<table>
<thead>
<tr>
<th>Message number</th>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>BUG9104</td>
<td>cdromFsLib: Logical sector number is out of range. (%u &gt; %u) in %s.</td>
</tr>
<tr>
<td>BUG9105</td>
<td>cdromFsLib: pBlkDev is NULL in %s.</td>
</tr>
<tr>
<td>BUG9106</td>
<td>cdromFsLib: Logical block is out of range val: %d. in %s.</td>
</tr>
<tr>
<td>BUG9107</td>
<td>cdromFsLib: pVDData is NULL in %s.</td>
</tr>
<tr>
<td>BUG9108</td>
<td>cdromFsLib: pVolDesc semaphore is NULL in %s.</td>
</tr>
<tr>
<td>BUG9109</td>
<td>cdromFsLib: VD_LIST_MAG Magic number-%d is not equal to magic number-%d in %s.</td>
</tr>
<tr>
<td>BUG9110</td>
<td>cdromFsLib: VD_SET_MAG Magic number-%d is not equal to magic number-%d in %s.</td>
</tr>
<tr>
<td>BUG9111</td>
<td>cdromFsLib: NULL parameter FD in %s.</td>
</tr>
<tr>
<td>BUG9112</td>
<td>cdromFsLib: Directory PT record is NULL in %s.</td>
</tr>
<tr>
<td>BUG9113</td>
<td>cdromFsLib: Dir ID length is 0 in %s.</td>
</tr>
<tr>
<td>BUG9114</td>
<td>cdromFsLib: NULL file name in %s.</td>
</tr>
<tr>
<td>BUG9115</td>
<td>cdromFsLib: NULL path name in %s.</td>
</tr>
<tr>
<td>BUG9116</td>
<td>cdromFsLib: workFD.FRecords is in %s.</td>
</tr>
</tbody>
</table>

### Table 11
Keycode management (LD 143) messages

<table>
<thead>
<tr>
<th>Message number</th>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>CCBR001</td>
<td>Invalid command.</td>
</tr>
<tr>
<td>CCBR002</td>
<td>Invalid argument.</td>
</tr>
<tr>
<td>CCBR003</td>
<td>Cannot get resource (pipe) for ovl143.</td>
</tr>
<tr>
<td>CCBR004</td>
<td>Unexpected signal raised.</td>
</tr>
<tr>
<td>CCBR005</td>
<td>Failed to submit the new keycode.</td>
</tr>
</tbody>
</table>
Table 11
Keycode management (LD 143) messages

<table>
<thead>
<tr>
<th>Message number</th>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>CCBR006</td>
<td>The current keycode failed validation. The new keycode has been retained.</td>
</tr>
<tr>
<td>CCBR007</td>
<td>Failed to revert to the old keycode.</td>
</tr>
<tr>
<td>CCBR008</td>
<td>Command applicable to IODU/C only.</td>
</tr>
<tr>
<td>CCBR009</td>
<td>New Keycode accepted. It will be activated during the next restart.</td>
</tr>
<tr>
<td>CCBR010</td>
<td>New Keycode deleted. The current keycode is retained.</td>
</tr>
<tr>
<td>CCBR011</td>
<td>Keycode Validation: General Error.</td>
</tr>
<tr>
<td>CCBR012</td>
<td>Keycode Validation: Security Device Error.</td>
</tr>
<tr>
<td>CCBR013</td>
<td>Keycode Validation: Keycode File Read Error.</td>
</tr>
<tr>
<td>CCBR014</td>
<td>Keycode Validation: Keycode Internal Format Error.</td>
</tr>
<tr>
<td>CCBR015</td>
<td>Keycode Validation: Keycode Validation Error.</td>
</tr>
<tr>
<td>CCBR016</td>
<td>Keycode Validation: Keycode Data Extraction Error.</td>
</tr>
<tr>
<td>CCBR017</td>
<td>Keycode Validation: Keycode Enhancement Error.</td>
</tr>
<tr>
<td>CCBR018</td>
<td>Keycode Validation: Internal Keycode Error &lt;err_code&gt;.</td>
</tr>
<tr>
<td>CCBR019</td>
<td>Password has keycode change commands denied.</td>
</tr>
</tbody>
</table>

Table 12
Core Common Equipment Diagnostic (CCED) messages

<table>
<thead>
<tr>
<th>Message number</th>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>CCED1000</td>
<td>Can’t switch back from side where IOP card is different.</td>
</tr>
<tr>
<td>CCED1001</td>
<td>SWO failed because IOP cards are different.</td>
</tr>
</tbody>
</table>
### Table 13
Core Input/Output Diagnostic (LD 137) messages

<table>
<thead>
<tr>
<th>Message number</th>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>CIOD051</td>
<td>Keycode failed validation against security device.</td>
</tr>
<tr>
<td>CIOD052</td>
<td>CMDU %d CD-ROM not responding.</td>
</tr>
<tr>
<td>CIOD053</td>
<td>CMDU %d CD-ROM corrupted or missing.</td>
</tr>
<tr>
<td>CIOD055</td>
<td>CMDU %d no CD-ROM on card.</td>
</tr>
<tr>
<td>CIOD0365</td>
<td>Failed to Switch back from side %d.</td>
</tr>
</tbody>
</table>

### Table 14
Installation messages

<table>
<thead>
<tr>
<th>Message number</th>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>INST0000</td>
<td>FATAL, Install cannot continue.</td>
</tr>
<tr>
<td>INST0002</td>
<td>Unexpected ROM image file &quot;%s&quot; format.</td>
</tr>
<tr>
<td>INST0003</td>
<td>System is not in SPLIT mode.</td>
</tr>
<tr>
<td>INST0004</td>
<td>Unable to determine the boot IODU number.</td>
</tr>
<tr>
<td>INST0005</td>
<td>Unable to obtain the hard disk partition size.</td>
</tr>
<tr>
<td>INST0006</td>
<td>Unable to find any database file under dir &quot;%s&quot;.</td>
</tr>
<tr>
<td>INST0007</td>
<td>Fail to seek to the end of split file &quot;%s&quot;.</td>
</tr>
<tr>
<td>INST0008</td>
<td>Fail to append to a non-existing file &quot;%s&quot;.</td>
</tr>
<tr>
<td>INST0009</td>
<td>Error installing Database.</td>
</tr>
<tr>
<td>INST0010</td>
<td>Unable to validate Hard disk partition &quot;%s&quot;.</td>
</tr>
<tr>
<td>INST0011</td>
<td>Unable to process the Install control file.</td>
</tr>
<tr>
<td>INST0012</td>
<td>Unable to open file &quot;%s&quot;.</td>
</tr>
<tr>
<td>INST0013</td>
<td>Unable to access database directory &quot;%s&quot;.</td>
</tr>
<tr>
<td>INST0014</td>
<td>Error parsing the Install control file.</td>
</tr>
</tbody>
</table>
### Table 14
**Installation messages**

<table>
<thead>
<tr>
<th>Message number</th>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>INST0015</td>
<td>Disk does not belong to this set of Installation diskettes.</td>
</tr>
<tr>
<td>INST0019</td>
<td>Unable to make directory &quot;%s&quot;.</td>
</tr>
<tr>
<td>INST0020</td>
<td>New directory conflicts with existing file &quot;%s&quot;.</td>
</tr>
<tr>
<td>INST0021</td>
<td>Unable to open file &quot;%s&quot; for checksum.</td>
</tr>
<tr>
<td>INST0022</td>
<td>Error reading file &quot;%s&quot; during checksum.</td>
</tr>
<tr>
<td>INST0023</td>
<td>Error reading floppy disk file &quot;%s&quot;.</td>
</tr>
<tr>
<td>INST0024</td>
<td>Unable to open hard disk file &quot;%s&quot; for writing.</td>
</tr>
<tr>
<td>INST0025</td>
<td>Unable to write to hard disk file &quot;%s&quot;.</td>
</tr>
<tr>
<td>INST0026</td>
<td>Software Error - Assume Quit selection.</td>
</tr>
<tr>
<td>INST0027</td>
<td>Error copying file &quot;%s&quot; to hard disk.</td>
</tr>
<tr>
<td>INST0028</td>
<td>Missing last segment of split file &quot;%s&quot;.</td>
</tr>
<tr>
<td>INST0029</td>
<td>Checksum of &quot;%s&quot; does not match the actual.</td>
</tr>
<tr>
<td>INST0030</td>
<td>Missing card-id file on IODU %d.</td>
</tr>
<tr>
<td>INST0031</td>
<td>New software is large than the maximum size.</td>
</tr>
<tr>
<td>INST0032</td>
<td>Software Error - Return Error.</td>
</tr>
<tr>
<td>INST0033</td>
<td>Unable to find the active &quot;%s&quot; slot.</td>
</tr>
<tr>
<td>INST0034</td>
<td>Unable to access the active &quot;%s&quot; card.</td>
</tr>
<tr>
<td>INST0035</td>
<td>Unable to get file name using DLO: &quot;%s&quot;.</td>
</tr>
<tr>
<td>INST0036</td>
<td>Unable to access file &quot;%s&quot;.</td>
</tr>
<tr>
<td>INST0037</td>
<td>Unable to open file &quot;%s&quot; for reading.</td>
</tr>
<tr>
<td>INST0038</td>
<td>Unable to write to hard disk, disk is full.</td>
</tr>
<tr>
<td>INST0039</td>
<td>Unable to copy file &quot;%s&quot;.</td>
</tr>
</tbody>
</table>
Table 14
Installation messages

<table>
<thead>
<tr>
<th>Message number</th>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>INST0040</td>
<td>Unable to close file &quot;%s&quot;.</td>
</tr>
<tr>
<td>INST0041</td>
<td>Unable to open directory &quot;%s&quot; for reading.</td>
</tr>
<tr>
<td>INST0042</td>
<td>Unable to read directory &quot;%s&quot;.</td>
</tr>
<tr>
<td>INST0043</td>
<td>Unable to close directory &quot;%s&quot;.</td>
</tr>
<tr>
<td>INST0044</td>
<td>Unable to rename file &quot;%s&quot; to &quot;%s&quot;.</td>
</tr>
<tr>
<td>INST0045</td>
<td>Unable to copy file from &quot;%s&quot; to &quot;%s&quot;.</td>
</tr>
<tr>
<td>INST0046</td>
<td>Fail to copy directory from &quot;%s&quot; to &quot;%s&quot;.</td>
</tr>
<tr>
<td>INST0047</td>
<td>Unable to initialize partition &quot;%s&quot;.</td>
</tr>
<tr>
<td>INST0048</td>
<td>Unable to find database file &quot;%s&quot;.</td>
</tr>
<tr>
<td>INST0049</td>
<td>Unable to access directory &quot;%s&quot;.</td>
</tr>
<tr>
<td>INST0050</td>
<td>No partition found, Install control file is corrupted.</td>
</tr>
<tr>
<td>INST0051</td>
<td>Cannot continue, System has Disk Redundancy on.</td>
</tr>
<tr>
<td>INST0052</td>
<td>Error in Database installl, file's size unmatched.</td>
</tr>
<tr>
<td>INST0053</td>
<td>Unable to find symbol for %s-ROM file.</td>
</tr>
<tr>
<td>INST0055</td>
<td>Current floppy disk does not have %s-ROM file.</td>
</tr>
<tr>
<td>INST0056</td>
<td>Cannot contact device on SCSI bus ID %d.</td>
</tr>
<tr>
<td>INST0057</td>
<td>Unable to read input from keyboard, please try again.</td>
</tr>
<tr>
<td>INST0060</td>
<td>Incorrect disk in drive, please insert the correct one.</td>
</tr>
<tr>
<td>INST0061</td>
<td>Unable to reset IOP card, slot number %d.</td>
</tr>
<tr>
<td>INST0062</td>
<td>Invalid date for leap year, day cannot exceed 29.</td>
</tr>
<tr>
<td>INST0063</td>
<td>Invalid date entered, please enter again.</td>
</tr>
<tr>
<td>INST0064</td>
<td>Invalid time entered, please enter again.</td>
</tr>
</tbody>
</table>
### Table 14
Installation messages

<table>
<thead>
<tr>
<th>Message number</th>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>INST0065</td>
<td>Fatal, fail to partition hard disk.</td>
</tr>
<tr>
<td>INST0066</td>
<td>Invalid year, please enter from %d to %d.</td>
</tr>
<tr>
<td>INST0067</td>
<td>Unable to create a PhysDev for Hard Disk.</td>
</tr>
<tr>
<td>INST0068</td>
<td>Unable to create BlockDev for /u partition.</td>
</tr>
<tr>
<td>INST0069</td>
<td>Unable to create BlockDev for /p partition.</td>
</tr>
<tr>
<td>INST0070</td>
<td>Unable to create BlockDev for /id partition.</td>
</tr>
<tr>
<td>INST0071</td>
<td>Unable to open /u partition.</td>
</tr>
<tr>
<td>INST0072</td>
<td>Unable to initialize /u partition.</td>
</tr>
<tr>
<td>INST0073</td>
<td>Unable to open /p partition.</td>
</tr>
<tr>
<td>INST0074</td>
<td>Unable to initialize /np partition.</td>
</tr>
<tr>
<td>INST0075</td>
<td>Unable to open /id partition.</td>
</tr>
<tr>
<td>INST0076</td>
<td>Unable to initialize /id partition.</td>
</tr>
<tr>
<td>INST0077</td>
<td>System Date is not correct, please set it to the current date.</td>
</tr>
<tr>
<td>INST0078</td>
<td>Fail to erase file &quot;%s&quot;.</td>
</tr>
<tr>
<td>INST0079</td>
<td>Fail to allocate memory for internal patch structure.</td>
</tr>
<tr>
<td>INST0080</td>
<td>Unable to mark patches for retention.</td>
</tr>
<tr>
<td>INST0081</td>
<td>Same release and issue, new patches are ignored.</td>
</tr>
<tr>
<td>INST0082</td>
<td>MDP package is not equipped, new patches are ignored.</td>
</tr>
<tr>
<td>INST0083</td>
<td>Unable to obtain the Database’s release and issue &quot;%s&quot;.</td>
</tr>
<tr>
<td>INST0084</td>
<td>Unable to find symbol for flash file %s.</td>
</tr>
<tr>
<td>INST0085</td>
<td>File context unmatched. &quot;%s&quot;: %s vs. &quot;%s&quot;: %s.</td>
</tr>
<tr>
<td>INST0087</td>
<td>Target slot not in %d...%d range.</td>
</tr>
</tbody>
</table>
### System messages

#### Table 14
Installation messages

<table>
<thead>
<tr>
<th>Message number</th>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>INST0088</td>
<td>Manual keycode insertion failed.</td>
</tr>
<tr>
<td>INST0089</td>
<td>Copy /p partition from other core failed.</td>
</tr>
<tr>
<td>INST0090</td>
<td>Unable to install software from CD-ROM to hard disk.</td>
</tr>
<tr>
<td>INST0091</td>
<td>Error reading CDROM file %s/%s.</td>
</tr>
<tr>
<td>INST0092</td>
<td>ERROR while trying to update direct.rec file.</td>
</tr>
<tr>
<td>INST0093</td>
<td>Security Device ERROR detected.</td>
</tr>
<tr>
<td>INST0094</td>
<td>Keycode format ERROR.</td>
</tr>
<tr>
<td>INST0095</td>
<td>Keycode validation ERROR.</td>
</tr>
<tr>
<td>INST0096</td>
<td>Cannot extract parameters from keycode.</td>
</tr>
<tr>
<td>INST0097</td>
<td>Invalid input to function instDiskPrompt.</td>
</tr>
<tr>
<td>INST0098</td>
<td>Error copying %s to %s.</td>
</tr>
<tr>
<td>INST0099</td>
<td>Could not locate &quot;%s&quot; firmware on (hard-disk/CDROM)</td>
</tr>
<tr>
<td>INST0122</td>
<td>Unable to write %d sector (start sector %d), to device on scsi bus ID %d</td>
</tr>
<tr>
<td>INST0127</td>
<td>Keycode file is corrupted. Check Keycode file.</td>
</tr>
<tr>
<td>INST0138</td>
<td>Unable to read %d sector (start sector %d), from device on scsi bus ID %d</td>
</tr>
<tr>
<td>INST0165</td>
<td>Unable to determine floppy size.</td>
</tr>
<tr>
<td>INST0166</td>
<td>Block device number %d on bus ID %d does not exist.</td>
</tr>
<tr>
<td>INST0167</td>
<td>Memory allocation problems.</td>
</tr>
<tr>
<td>INST0168</td>
<td>Failed to copy the new keycode on hard disk.</td>
</tr>
<tr>
<td>INST0169</td>
<td>Failed to replace the keycode with the new one.</td>
</tr>
<tr>
<td>INST0170</td>
<td>CP type, specified by keycode, mismatches the actual CP type.</td>
</tr>
</tbody>
</table>
### Table 15
**Small Computer System Interface (SCSI) messages**

<table>
<thead>
<tr>
<th>Message number</th>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>SCSI0113</td>
<td>CDROM %s not active.</td>
</tr>
<tr>
<td>SCSI0114</td>
<td>File System Initialization failed for CDROM /cd%d.</td>
</tr>
<tr>
<td>SCSI0115</td>
<td>Error Reading from CDROM, sector %d, errNo %x, sense %x, addSense %x.</td>
</tr>
<tr>
<td>SCSI0116</td>
<td>An attempt to write to CDROM</td>
</tr>
</tbody>
</table>

### Table 16
**System Report (SRPT) messages**

<table>
<thead>
<tr>
<th>Message number</th>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>SRPT4595</td>
<td>Failed to read IOP Card ID on Core Side %d.</td>
</tr>
<tr>
<td>SRPT4596</td>
<td>IOP cards are not identical.</td>
</tr>
<tr>
<td>SRPT4597</td>
<td>KC: failed to retrieve data from keycode file: “%s”.</td>
</tr>
<tr>
<td>SRPT4598</td>
<td>KC mismatch: System ID in keycode “%s” and in direct.rec.</td>
</tr>
<tr>
<td>SRPT4599</td>
<td>KC %s: “%s” does not match the direct record.</td>
</tr>
<tr>
<td></td>
<td>Keycode value = %d, direct.rec value = %d.</td>
</tr>
<tr>
<td>SRPT4600</td>
<td>KC %d: Keycode Error Code: %p.</td>
</tr>
<tr>
<td>SRPT4601</td>
<td>KC: The new Keycode has been enabled.</td>
</tr>
<tr>
<td>SRPT4602</td>
<td>KC: The new Keycode has been rejected.</td>
</tr>
<tr>
<td></td>
<td>Use KSHO in LD 143 to check it.</td>
</tr>
<tr>
<td>SRPT4603</td>
<td>KC %s: Cannot open file “%s”</td>
</tr>
<tr>
<td>SRPT4604</td>
<td>KC %d: Security Device error on Core side %</td>
</tr>
<tr>
<td>SRPT4605</td>
<td>KC %d: Internal Format error in keycode file “%s”</td>
</tr>
<tr>
<td>SRPT4606</td>
<td>KC %d: Validation error in keycode file “%s”</td>
</tr>
<tr>
<td>SRPT4607</td>
<td>KC %d: Parameter Extraction error from keycode file “%s”</td>
</tr>
</tbody>
</table>
### Table 16
**System Report (SRPT) messages**

<table>
<thead>
<tr>
<th>Message number</th>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>SRPT4608</td>
<td>KC %d: Keycode Enhancement error using keycode file &quot;%s&quot;</td>
</tr>
<tr>
<td>SRPT4609</td>
<td>KC: %s error. From file: &quot;%s&quot;. To file: &quot;%s&quot;. Error = %p</td>
</tr>
<tr>
<td>SRPT4610</td>
<td>KC: failed to remove file: &quot;%s&quot;. Error = %p</td>
</tr>
<tr>
<td>SRPT4611</td>
<td>KC: failed to get data from the &quot;%s&quot; file. Code = %</td>
</tr>
<tr>
<td>SRPT4612</td>
<td>KC: file %s %s %s</td>
</tr>
<tr>
<td>SRPT4613</td>
<td>KC Error. &quot;%s&quot; returns with error code: %d &quot;%s&quot; error.</td>
</tr>
<tr>
<td>SRPT4614</td>
<td>KC Envelope Error: %s.</td>
</tr>
<tr>
<td>SRPT4615</td>
<td>Security Device on Core Side %d is missing \nCheck and reseat Security Device.</td>
</tr>
<tr>
<td>SRPT4616</td>
<td>Security Device on Core Side %d is corrupted \nCheck and reseat Security Device.</td>
</tr>
<tr>
<td>SRPT4617</td>
<td>Security Device on Core Side %d is invalid \nCheck and reseat Security Device.</td>
</tr>
<tr>
<td>SRPT4618</td>
<td>KC: Keycode file is missing \nPlease reinstall software from CDROM</td>
</tr>
<tr>
<td>SRPT4619</td>
<td>WARNING: Last Archive Procedure had failed \nNo archives were completed since %s %02d %02d:%02d:00 %d \nUse LD 143 to perform Attended Backup (ABKO)</td>
</tr>
<tr>
<td>SRPT4620</td>
<td>Error %p while %s status of last archive.</td>
</tr>
<tr>
<td>SRPT4621</td>
<td>Results of the last Backup are not available. \nReason: %s.</td>
</tr>
<tr>
<td>SRPT4622</td>
<td>Security Device on Core Side %d is missing. \nCheck and reseat Security Device.</td>
</tr>
</tbody>
</table>
### Table 16
#### System Report (SRPT) messages

<table>
<thead>
<tr>
<th>Message number</th>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>SRPT4623</td>
<td>Security Device on Core Side %d is corrupted. Check and reseat Security Device.</td>
</tr>
<tr>
<td>SRPT4624</td>
<td>Security Device on Core Side %d is invalid. Check and reseat Security Device.</td>
</tr>
<tr>
<td>SRPT4625</td>
<td>Keycode file type of %s is not supported. Check that correct keycode is used.</td>
</tr>
<tr>
<td>SRPT4626</td>
<td>Can't read keycode file %s - insufficient buffer. Check that correct keycode is used.</td>
</tr>
<tr>
<td>SRPT4627</td>
<td>IO problem for Keycode %s. Check that correct keycode is used.</td>
</tr>
<tr>
<td>SRPT4628</td>
<td>Keycode file %s has wrong format. Check that correct keycode is used.</td>
</tr>
<tr>
<td>SRPT4629</td>
<td>Keycode file %s is not found. Check that correct keycode is used.</td>
</tr>
</tbody>
</table>

### Table 17
#### Tape Emulation (TEMU) messages

<table>
<thead>
<tr>
<th>Message number</th>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>TEMU0124</td>
<td>zdrv: Failed to restore %s.</td>
</tr>
<tr>
<td>TEMU0125</td>
<td>Error in processing file %s. File has wrong format or is missing.</td>
</tr>
<tr>
<td>TEMU0126</td>
<td>File %s is not found on %s.</td>
</tr>
<tr>
<td>TEMU0127</td>
<td>Diskette does not belong to this set</td>
</tr>
<tr>
<td>TEMU0128</td>
<td>Missing part of a split file</td>
</tr>
</tbody>
</table>
Table 17  
Tape Emulation (TEMU) messages

<table>
<thead>
<tr>
<th>Message number</th>
<th>Message</th>
</tr>
</thead>
</table>
| TEMU0129       | BackUP process ended successfully.  
Number of floppy diskette(s) used: %d.  
Amount of space remaining on the last floppy: %d. |
| TEMU0130       | CheckSum Problems : %s. |
| TEMU0131       | Problem setting previous database files information. |
| TEMU0132       | Problem getting previous database files information. |
| TEMU0133       | Inflating file: %s  
size: %d KBytes. |
| TEMU0134       | File: %s  
Inflated to size: %d KBytes. |
| TEMU0135       | BackUP process ended successfully.  
Number of floppy diskette(s) used: %d. |
| TEMU0136       | %s is not a directory. |
| TEMU0137       | Error creating directory %s. |
| TEMU0138       | Restoring Process ended successfully. |
| TEMU0139       | Checking capacity of FD - error Pcmdu - NULL. |
| TEMU0140       | Error initializing floppy diskette %s. |
| TEMU0141       | Not enough space for Unattended backup. |
| TEMU0142       | Can't Get Active CMDU. |
| TEMU0143       | Hard disk %s space exhausted |
| TEMU0144       | Please check that floppy on side %d is available |
| TEMU0145       | Creating of Archive master file failed.  
Restart backup process with new floppies. |
### Table 17
**Tape Emulation (TEMU) messages**

<table>
<thead>
<tr>
<th>Message number</th>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>TEMU0146</td>
<td>%x error reading from file %s</td>
</tr>
<tr>
<td>TEMU0147</td>
<td>%x Can't get file info for file %s</td>
</tr>
<tr>
<td>TEMU0148</td>
<td>%x Can't open directory %s</td>
</tr>
<tr>
<td>TEMU0149</td>
<td>Compressing file: %s</td>
</tr>
<tr>
<td></td>
<td>size: %d KBytes</td>
</tr>
<tr>
<td>TEMU0150</td>
<td>File: %s</td>
</tr>
<tr>
<td></td>
<td>Compressed to size: %d KBytes</td>
</tr>
<tr>
<td>TEMU0151</td>
<td>%x Error Compressing file %s</td>
</tr>
<tr>
<td>TEMU0152</td>
<td>%x Compression error : %s %s</td>
</tr>
<tr>
<td>TEMU0153</td>
<td>UnCompressing file: %s to %s</td>
</tr>
<tr>
<td>TEMU0154</td>
<td>%x UnCompression file error : %s %s</td>
</tr>
<tr>
<td>TEMU0155</td>
<td>arcLabFlag is set. Device %s is not initialized.</td>
</tr>
</tbody>
</table>
List of Terms

Database Transfer Utility
Used to transfer the customer database from an IOP/ CMDU drive onto 2MB diskettes that can be read by the IODU/C. Each 4MB diskette supports one processor type (NT6D66 68030 Call Processor, NT9D19 68040 Call Processor, and NT5D21 NT68060 Call Processor).

Direct Cabling
Customer database transfer where the MDU (or SMDU) is cabled to the IODU/C using an NT5D50AA cable, and the database is transferred directly from one hard disk to another.

DKA
Distributor Keycode Application. A Windows 95® application that supports retrieval of keycodes from a Keycode Server via a modem, manual entry of keycodes, and reading keycode files. DKA is supported in non-European markets only.

IODU/C
NT5D61 Input/Output Disk Unit with CD-ROM. Replaces the NT5D20 IOP/CMDU or NT6D63 IOP and NT6D64 CMDU cards in Options 51C, 61C, 81, and 81C with X11 Release 23 and later. Introduces software installation from CD-ROM, an industry-standard 2MB floppy drive, and the use of a keycode and Security Device to activate system software, features, and ISM limits.

Keycode
A file which specifies the release and issue of X11 software, the specific software generic, and the specific set of feature packages and ISM limits. A keycode is validated against Security Device(s) mounted on the IODU/C card(s).
Keycode Retrieval Utility
A Nortel web site that can be used by European distributors to download keycodes. The Nortel Keycode Retrieval Utility is supported in European markets only.

Keycode Acknowledgment
A hardcopy printout of the keycode file, including a listing of the keycode parameters.

LD 143
A new overlay which supports keycode administration and attended database archive and restore.

Machine Type
First two numeric characters of Software Version, which define the system type and processor. For example, a Machine Type of 18 refers to an Option 61C with an NT6D66 Call Processor card.

NT SDID
The 8 digit Security Device number, which is visible on the Security Device.

SDID
The 16 digit internal Security Device number.

Security Device
A small metal device which is mounted on the IODU/C card and validates the keycode. Unlike Security Cartridges, Security Devices do not need to be replaced with a software upgrade.

Software Version
Consists of Machine Type (first two numeric characters) and Generic (second two numeric characters). Example: 1811.

System Serial Number
A unique number which identifies each Meridian 1 switch.
Index

A
ABKO command, 82
ARES command, 83
attended backup, 82
attended restore, 83

B
BKO command, 84

C
comparing keycodes, 64
converting software, 43
country code, 94
creating keycode diskettes, 121
creating shortcuts, 92

database transfer, 17, 141
direct cabling method, 144
Database Transfer Utility, 142
deleting keycodes, 78
Dial-Up Networking®, 93
Dial-Up Server, 95
Distributor Keycode Application, 87, 107
DKA, 87, 107
Dial-Up Networking®, 93
hardware and software requirements, 88
installation, 88
Manual entry, 104
modem requirements, 88
Reading from a File, 103
downloading a keycode from KDS, 97
downloading keycodes, 97
electronic file transfer, 68, 76
error messages, 160, 183
installation, 183
LD 137, 186
LD 143, 183, 184, 185, 191, 193
fault isolation, 179
feature expansion, 17, 18, 63
file names, 99
hard disk synchronization, 54
HELP command, 81
HyperTerminal®, 68
Incremental Software Management, 63
installation of DKA, 88
installing
IDOUC card, 20
IDOUC card
differences from the IOP/CMU card, 18
replacement, 123
ISM limit modification, 63
KDIF, 64
KDIF command, 80
Keycode Delivery System (KDS), 97
keycode download, 97
NT5D61 IODU/C reference guide
keycode installation
  electronic file transfer, 68
  manual entry, 72
  using diskettes, 64
keycode management, 75
keycode manual entry, 76
keycode upload, 76
keycodes, 15
  activating, 69
  comparing, 64
  creating keycode diskettes, 121
  delivery, 63
  downloading, 97
  file name, 99
  guidelines, 16
  installation, 63
  manual entry, 104
  troubleshooting, 102
KMAN command, 72, 76
KOUT command, 78
KRVR command, 77
KSHO command, 79
KSTT command, 78
KUPL, 68
KUPL command, 76

L
LD 135 program
  Security Device replacement, 64
LD 143, 75

M
manual keycode entry, 72
manually entering a keycode, 104
modem configuration, 93
modem requirements (DKA), 88

N
network protocols, 95
NT order number, 99
NTI number, 99

O
option 61C systems
  parallel reloads
    procedure, 83
option 81 systems
  parallel reloads
    procedure, 83
option 81C systems
  parallel reloads
    procedure, 83

P
parallel reloads, 44
  backing out, 55
    procedure, 75, 82
  options 61C/81/81C, 83
Phase 7, 154
Phase 8, 141, 142, 144
printing keycodes, 78

R
read from a file, 103
release 23 memory requirements, 18
replacing IODU/C cards, 123
RES command, 85
restoring database, 85
reverting to previous keycode, 77

S
Security Device, 14
  replacing, 133
server type, 95
server types, 95
software conversion, 43
software install kit, 13
Software Installation Tool
description of menus, 157
software upissue, 43
synchronizing hard disks, 54
system ID, 99

T
TCP/IP, 95
testing, 50, 53
troubleshooting, 102

U
unattended backup, 84
unattended restore, 85
Meridian 1
NT5D61 IODU/C reference guide

Copyright © 1997–2000 Nortel Networks
All Rights Reserved
Information is subject to change without notice. Nortel Networks reserves the right to make changes in design or components as progress in engineering and manufacturing may warrant. This equipment has been tested and found to comply with the limits for a Class A digital device pursuant to Part 15 of the FCC rules, and the radio interference regulations of Industry Canada. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses and can radiate radio frequency energy, and if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at their own expense.
SL-1 and Meridian 1 are trademarks of Nortel Networks. Microsoft® is a registered trademark and Windows™ is a trademark of Microsoft Corporation.
Publication number:
P0912861
Document release: Standard 6.00
Date: April 2000
Printed in Canada

NORTEL NETWORKS
How the world shares ideas.